While Deltek has attempted to verify that the information in this document is accurate and complete, some typographical or technical errors may exist. The recipient of this document is solely responsible for all decisions relating to or use of the information provided herein.

The information contained in this publication is effective as of the publication date below and is subject to change without notice.

This publication contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, or translated into another language, without the prior written consent of Deltek, Inc.

This edition published September 2016.
© Deltek, Inc.

Deltek's software is also protected by copyright law and constitutes valuable confidential and proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction or distribution of the program or any portion thereof could result in severe civil or criminal penalties.

All trademarks are the property of their respective owners.
Contents

Overview .......................................................................................................................................... 1
For Additional Information ............................................................................................................... 2
  Customer Care Connect Site ...................................................................................................... 2
  Documentation for this Release ................................................................................................. 3
Pre-Installation Information ....................................................................................................... 4
  Changes to Supported Environments and Technical Considerations in Vision 7.6 ............ 4
  Upgrade from Vision 7.5 ............................................................................................................. 5
  Upgrade from Vision 7.4 or Earlier Versions ............................................................................. 5
  Considerations Prior to Upgrading .......................................................................................... 12
  Custom Programming, Including Custom Invoices and Custom Reports ................................ 15
  Known Issues ........................................................................................................................... 15
Important Notes about the Vision Installation ............................................................................. 16
  Setup Log File .......................................................................................................................... 16
  Microsoft SQL Server Express Edition .................................................................................... 16
  Microsoft SQL Server Reporting Services—Custom Reports and Custom Invoices .......... 16
  Connect for Microsoft Outlook ............................................................................................... 17
  Revenue Generation and Gains and Losses .......................................................................... 17
  Export Reports as Files ............................................................................................................. 17
Download and Install Vision 7.6 ............................................................................................... 19
  Upgrade Considerations .......................................................................................................... 19
Deploy Vision 7.6 on Client Workstations ................................................................................ 20
  Subsequent Logins .................................................................................................................. 20
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release ........................................ 21
  Accounting ............................................................................................................................. 21
  Analysis Cubes ......................................................................................................................... 23
  Architecture ............................................................................................................................. 23
  Billing ..................................................................................................................................... 24
  Configuration .......................................................................................................................... 25
  Dashboard ............................................................................................................................... 26
  Human Resources .................................................................................................................... 27
  Info Center ............................................................................................................................... 27
  Planning .................................................................................................................................. 30
  Proposals ................................................................................................................................. 31
  Purchasing ............................................................................................................................... 31
  Reporting ................................................................................................................................ 32
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time and Expense</td>
<td>38</td>
</tr>
<tr>
<td>Transaction Center » Transaction Lists and Posting Logs</td>
<td>40</td>
</tr>
<tr>
<td>Utilities</td>
<td>40</td>
</tr>
<tr>
<td>Database Changes</td>
<td>41</td>
</tr>
<tr>
<td>New Tables</td>
<td>41</td>
</tr>
<tr>
<td>Removed Tables</td>
<td>41</td>
</tr>
<tr>
<td>New Columns in Existing Tables</td>
<td>42</td>
</tr>
<tr>
<td>Removed Columns from Existing Tables</td>
<td>50</td>
</tr>
<tr>
<td>Columns Changed in Existing Tables</td>
<td>50</td>
</tr>
<tr>
<td>New Objects</td>
<td>52</td>
</tr>
<tr>
<td>Removed Objects</td>
<td>53</td>
</tr>
<tr>
<td>Appendix A: Software Issues Resolved and Enhancements in Vision 7.5 Cumulative Updates</td>
<td>54</td>
</tr>
<tr>
<td>Cumulative Update 07: Released May 26, 2016</td>
<td>55</td>
</tr>
<tr>
<td>Software Enhancements</td>
<td>55</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>55</td>
</tr>
<tr>
<td>Cumulative Update 06: Released May 13, 2016</td>
<td>57</td>
</tr>
<tr>
<td>Software Enhancements</td>
<td>57</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>58</td>
</tr>
<tr>
<td>Cumulative Update 05: Released April 15, 2016</td>
<td>68</td>
</tr>
<tr>
<td>Regulatory Enhancements</td>
<td>68</td>
</tr>
<tr>
<td>Software Enhancements</td>
<td>68</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>68</td>
</tr>
<tr>
<td>Cumulative Update 04: Released March 18, 2016</td>
<td>80</td>
</tr>
<tr>
<td>Software Enhancements</td>
<td>80</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>84</td>
</tr>
<tr>
<td>Cumulative Update 03: Released February 19, 2016</td>
<td>93</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>93</td>
</tr>
<tr>
<td>Cumulative Update 02: Released January 22, 2016</td>
<td>106</td>
</tr>
<tr>
<td>Regulatory Enhancements</td>
<td>106</td>
</tr>
<tr>
<td>Software Enhancements</td>
<td>110</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>113</td>
</tr>
<tr>
<td>Cumulative Update 01: Released December 18, 2015</td>
<td>126</td>
</tr>
<tr>
<td>Regulatory Enhancements</td>
<td>126</td>
</tr>
<tr>
<td>Software Enhancements</td>
<td>129</td>
</tr>
<tr>
<td>Software Issues Resolved</td>
<td>132</td>
</tr>
</tbody>
</table>
Overview

Welcome to the *Deltek Vision 7.6 Release Notes: Technical Considerations*. These release notes contain a summary of the following:

- Installation and upgrade information
- Software issues resolved
- Database changes

For information regarding the new features and enhancements in this release, see the *Deltek Vision 7.6 Release Notes: New Features and Enhancements*. 
For Additional Information

Customer Care Connect Site
The Deltek Customer Care Connect site is a support Web site for Deltek customers who purchase an Ongoing Support Plan (OSP).

The following are some of the many options that the Customer Care Connect site provides:

- Search for product documentation, such as release notes, install guides, technical information, online help topics, and white papers
- Ask questions, exchange ideas, and share knowledge with other Deltek customers through the Deltek Connect Customer Forums
- Access Cloud specific documents and forums
- Download the latest versions of your Deltek products
- Search Deltek’s knowledge base
- Submit a support case and check on its progress
- Transfer requested files to a Customer Care analyst
- Subscribe to Deltek communications about your products and services
- Receive alerts of new Deltek releases and hot fixes
- Use Quick Chat to submit a question to a Customer Care analyst online

For more information regarding Deltek Customer Care Connect, refer to the online help available from the Web site.

Access Customer Care Connect

To access the Customer Care Connect site:

2. Enter your Customer Care Connect Username and Password.
3. Click Log In.

If you forget your username or password, you can click the Account Assistance button on the login screen for help.
Documentation for this Release

Release notes and other guides are available for this release. You can download these documents in two ways.

**Deltek Software Manager**

The Documents tab in Deltek Software Manager lists all of the documents associated with a release and lets you download the ones that you want.

**To download documents:**

1. On the Deltek Customer Care site, click the Product Downloads tab, then select Launch Deltek Software Manager.
2. When the Deltek Software Manager opens, highlight a release in the left pane.
3. Click the Documents tab to display a list of available documents for the release.
4. Select the documents that you want.
5. Click View Download Queue to see a list of documents that you selected.
6. Click Download.

**Customer Care Site Enterprise Search**

Use the search feature to find specific documents or to see a list of all documents associated with a release. Then open or download the ones that you want.

**To download documents:**

1. On the Deltek Customer Care site, click Enterprise Search.
2. Select Release Documentation as the Source.
3. Perform one of the following actions:
   - To see a list of all available documentation for a release, enter the product and release number (for example, Vision 7.6) in the search field.
   - To find a specific document, enter a description of the document (for example, Vision 7.6 release notes) in the search field.
4. Click on the document, and then choose to open or save it.
Pre-Installation Information

Review the contents of this section before you install Deltek Vision 7.6.

For a complete list of the supported and non-supported platforms and other technical considerations that apply for Vision 7.6, see the following Vision documentation:

- Deltek Product Support Compatibility Matrix
- Deltek Vision 7.6 Technical Installation Guide

You can download these documents from the Deltek Customer Care Connect site.

Changes to Supported Environments and Technical Considerations in Vision 7.6

The technical considerations listed in the following table apply to Vision 7.6.

The upgrade process will vary based on the version of Vision that you are upgrading from. Refer to the appropriate upgrade topic in the next section for more information.

<table>
<thead>
<tr>
<th>Technical Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>64-bit Support</td>
<td>Vision 7.5 and later versions will run natively as a 64-bit application on the web/application server. The Vision client side components are still 32-bit. Vision will now install to the \Program Files directory by default. Upgrade installations will install clean to \Program Files and will rename the \Program Files (x86) installation directly by appending OLD. See the Deltek Vision 7.6 Installation Guide for detailed instructions on important installation and upgrade notes.</td>
</tr>
<tr>
<td>Client Operating System</td>
<td>Windows 10 and Microsoft Edge browser are supported with Vision 7.6.</td>
</tr>
<tr>
<td>Microsoft Windows Server 2008 R2</td>
<td>Vision can no longer be run on Microsoft Windows Server 2008 R2.</td>
</tr>
<tr>
<td>Microsoft .NET Framework</td>
<td>Microsoft .NET Framework 4.5.2 is required for Vision 7.6. You must install it on all tiers where Vision will be installed and on the client tier. The following are no longer supported: .NET Framework 4.5, 4.5.1 .NET Framework 3.5 SP1</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>The following CU versions are now supported with Vision 7.6: Microsoft SQL Server 2014 SP1 CU6 Microsoft SQL Server 2012 SP3 CU3 Microsoft SQL Server 2008 R2 is no longer supported.</td>
</tr>
</tbody>
</table>
### Technical Considerations

<table>
<thead>
<tr>
<th>Technical Consideration</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tableau Server          | Tableau Server 9.2.0 is the required version for Vision 7.6 Performance Management. If you have one of the following, you must upgrade to Tableau Server 9.2.0 after you upgrade to Vision 7.6:  
- Tableau Server 8.0.2 installed (with Vision 7.1 or 7.2),  
- Tableau Server 8.1.6 installed (with Vision 7.3)  
- Tableau 8.2 installed (with Vision 7.4)  
- Tableau 9.0.4 installed (with Vision 7.5)  

See the Deltek Vision 7.6 Installation and Configuration Guide for Performance Management for detailed instructions on performing the upgrade. |

### Supported Versions and Compatible Versions

Supported versions are the most current, actively tested technologies that are used to deploy Vision. Compatible versions are recent technologies that have been previously supported and tested for deploying Vision. Compatible versions are not actively undergoing testing but are believed to be compatible with Vision.

For a full explanation of supported versus compatible versions as well as a detailed list of Microsoft SQL Server releases (R), service packs (SP), and cumulative updates (CU) that Vision supports, see the Deltek Product Support Compatibility Matrix. You can download this document at the Deltek Customer Care Connect site.

KB article 65226 at the Customer Care Connect site also provides a list of the currently supported versions of Microsoft SQL Server.

### Upgrade from Vision 7.5

If you are upgrading from Vision 7.5, the upgrade detects the Vision 7.5 installation and installs directly into the existing folder structure using the current Vision settings.

### Upgrade from Vision 7.4 or Earlier Versions

If you are upgrading from Vision 7.4 or an earlier version:

- The upgrade process does not install directly in the existing folder structure.
- Vision 7.6 installs into a new folder structure while preserving and “remembering” settings from your previous Vision installation.
- The Vision 7.6 installation:
  - Detects the existing deployment model and makes recommendations and prepopulates settings based on that deployment model.
  - Takes settings from your existing web.config and databases.enc files and uses them to create a script that you can apply after the installation to upgrade your database. This script is created only during the installation on the Web/Application tiers because that is where the web.config and databases.enc files are located.
Pre-Installation Information

Supports upgrades from Vision 6.x and 7.x on all tiers: Web, Application, Process Server, Report, and Database.

Do Not Uninstall Prior Version Before Installing Vision 7.6

Because the Vision 7.6 installer preserves and applies settings from your existing implementation, you should not uninstall Vision before installing Vision 7.6.

You should also save any custom DLLs or reports for use by Vision 7.6.

After you perform the installation and confirm that your settings migrated correctly, you can delete the old installation directories.

Migrating/Upgrading To a New Server

If your existing Vision Web/Application Server is on a version of Windows that is no longer supported, you must perform a new installation. Any custom reports, DLLs, web.config settings or other configuration changes that are on the server will not be migrated.

Review the summary of changes below. If you customized your previous version, you will have to apply the customization again to the new deployment, keeping in mind the changes listed in the tables below.

If your existing Vision Database/Report server is on a version that is no longer supported, you must restore or move your database to the new server prior to performing the installation.

Apply Database Script

During the upgrade installation, Vision setup attempts to detect the Product and Market Type of your installation and then uses that information to configure your database. In prior versions, these values were automatically applied to the registry of the web/application server. Now, if you are not performing the installation on your existing server or are using a new server, setup will be unable to determine the Product and Market Type of your implementation and will default to Vision for the ProductType and PS for the MarketType. These values impact the login screen, interface, images, business functionality, and the help system so it is important to set them correctly.

Refer to the following table for the update queries for each Deltek product. The database ProductType and MarketType values can only be set to one value and must match the intended implementation. Run the query for all existing and new customers using Vision 7.6 based on the product type and market type.

<table>
<thead>
<tr>
<th>Product</th>
<th>Scripts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deltek Vision</td>
<td><code>update FW_CFGSystem set ProductType = 'Vision'</code>&lt;br&gt;<code>update FW_CFGSystem set MarketType = 'PS'</code></td>
</tr>
<tr>
<td>Deltek GovWin CRM</td>
<td><code>update FW_CFGSystem set ProductType = 'GovWin'</code>&lt;br&gt;<code>update FW_CFGSystem set MarketType = 'GC'</code></td>
</tr>
<tr>
<td>Deltek Ajera CRM</td>
<td><code>update FW_CFGSystem set ProductType = 'Ajera'</code>&lt;br&gt;<code>update FW_CFGSystem set MarketType = 'PS'</code></td>
</tr>
<tr>
<td>Product</td>
<td>Scripts</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deltek Ajera CRM with Ajera Synchronization</td>
<td>update FW_CFGSystem set ProductType = 'Ajera'</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'PS'</td>
</tr>
<tr>
<td>Deltek CRM</td>
<td>▪ Professional Services</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set ProductType = 'CRM'</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'PS'</td>
</tr>
<tr>
<td></td>
<td>▪ Government Contractors</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set ProductType = 'CRM'</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'GC'</td>
</tr>
<tr>
<td>Deltek CRM with Ajera Synchronization</td>
<td>update FW_CFGSystem set ProductType = 'CRM</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'PS'</td>
</tr>
<tr>
<td>Deltek Resource Planning</td>
<td>▪ Professional Services</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set ProductType = 'RP'</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'PS'</td>
</tr>
<tr>
<td></td>
<td>▪ Government Contractors</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set ProductType = 'RP'</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'GC'</td>
</tr>
<tr>
<td>Deltek Resource Planning and CRM</td>
<td>▪ Professional Services</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set ProductType = 'RP</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'PS'</td>
</tr>
<tr>
<td></td>
<td>▪ Government Contractors</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set ProductType = 'RP</td>
</tr>
<tr>
<td></td>
<td>update FW_CFGSystem set MarketType = 'GC'</td>
</tr>
</tbody>
</table>
## Installation Location/Configurations

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Previous</th>
<th>New</th>
</tr>
</thead>
</table>
| Installation Location                  | <drive>:\Program Files (x86)\Deltek\Vision                             | ▪ The new default folder location is <drive>:\Program Files\Deltek\Vision  
    ▪ The previous folder (typically found in the 32-bit program files folder) is renamed.  
      ▪ “OLD” is appended to the end of the folder name. For example VisionOLD.  
      ▪ A readme.txt file is inserted into the renamed folder. It contains the text:  
        “This is a previously used Deltek Vision directory that is no longer used and can be safely removed after ensuring that all of your custom DLLs and custom reports have been copied to the new directory (<drive>:\Program Files\Deltek\Vision)” |
| Programs and Features                  | Deltek Vision 7.4                                                        | The previous version (Deltek Vision 7.4) is removed from Add/Remove Programs and replaced with new Deltek Vision 7.6 product name and release GUID. |
| Registry Key Location                  | HKLM\Software\Wow6432\Deltek\Vision                                    | ▪ HKLM\Software\Deltek\Vision  
    ▪ The entries in the previous registry location below the Vision folder are removed. |
| Application Pool                       | Application Pools is not removed                                         | ▪ The existing Application Pool is updated with the following:  
    Updates the Enable32bitOnWow64 from True to False |
| Virtual Directories/Applications       | Virtual Directories/Applications remains.                                | The Virtual Directories/Applications physical directory changes to the new “<drive>:\Program Files\Deltek\Vision” TARGETDIR.           |
| Process Server Configuration and executable | Process Server service                                               | ▪ The Process Server executable uses the new “<drive>:\Program Files\Deltek\Vision” TARGETDIR location.  
    ▪ If you changed the Process Server service identity account after installing a previous version of Vision, Vision prompts you to enter the credentials password for the account during the upgrade installation on any tier that contains the Process Server service.  
    If you do not know the password, enter the text bypass and the installation continues without setting the password on the identity for the service. After installation, you must update the Deltek Vision Process Server service account with the correct password or the service will not start. |
Custom Web.Config Settings Migration

Some custom settings added to the web.config file on the web/application server have been migrated to the database and can be configured from within the application. Because of this change, database upgrades are only supported from any deployment option that includes the Web/Application tier installations.

During any installation using a deployment option with the web/application tier installations, setup copies the prior version’s web.config file and uses it. It reads the web.config from the prior deployment and dynamically creates a v_WebConfigMigration.sql script file containing the custom settings noted below and builds the master upgrade script with those new settings so that the database is updated accordingly. You can still choose to upgrade databases post installation.

On upgrades, unused web.config values are commented out and others not being used anymore are removed.

<table>
<thead>
<tr>
<th>Original Setting</th>
<th>New Location in Database (Table.Field)</th>
<th>How to Edit: Launch Application » Navigate to Configuration » General » System Settings »</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaxEmailSize</td>
<td>CFGEmail.MaxEmailSize</td>
<td>Email Tab » Email Size Limit (Megabytes)</td>
</tr>
<tr>
<td>EmailChunkSize</td>
<td>CFGEmail.EmailChunkSize</td>
<td>Email Tab » Number of Emails to Send at Once</td>
</tr>
<tr>
<td>WebAPI_EnableWorkflow</td>
<td>FW_CFGSystem.WebAPIEnableWorkflow</td>
<td>Miscellaneous Tab » Workflow section » Allow APIs to Trigger Workflows</td>
</tr>
<tr>
<td>SessionTimeout</td>
<td>FW_CFGSystem.SessionTimeout</td>
<td>Miscellaneous Tab » Application Session Timeout (minutes)</td>
</tr>
<tr>
<td>AllowFileSave</td>
<td>FW_CFGSystem.AllowFileSave</td>
<td>Miscellaneous Tab » Export Reports as Files Section</td>
</tr>
</tbody>
</table>

Custom Changes Applied at Customer Sites

If you previously customized Vision:

- **Custom DLLs** – You need to test all custom workflow DLLs (and any third party DLLs) to verify that they work in 64-bit mode. If they are compiled with AnyCPU, they should work. After testing, you can copy them into the new installation folder

- **Custom Reports (not in the database)** – You need to copy all custom reports not stored in the report server database to the new installation folder and **Load Report Files** into the database.

Shared databases.ENC File Path

You can now use a shared databases.ENC file path. If your Vision deployment includes multiple web/application servers, or even just a dedicated process server, the shared path will eliminate the need to synchronize changes made to databases.ENC across your servers.
Pre-Installation Information

See the Deltek Vision Advanced Technical Administration Guide for more information.

Changes to the Upgrade Installation Process
This section includes a list of changes affecting the tiers in all the deployment/installation models.

For example, if you are performing a Web/Application/Process Server installation for the Dual Server (Two-Tier) Configuration 1 deployment, the details listed in the Web/Application and Process Server tiers below will apply.

For an overview of the logical tiers and deployment models, see:
- Logical Tiers
- Installation/Deployment Models

Database Tier

The installer will not create a deltekvision76.sql database conversion script file. The database conversion script file is created only on the web/application server because the web.config file exists only on the web/application tier.

- The Installer attempts to detect previous tier installations (deployment model) and makes a recommendation about what you should select on the dialog boxes.
- A readme.txt file is inserted into the renamed folder, containing the following text:
  “This is a previously used Deltek Vision directory that is no longer used and can be safely removed after ensuring that all of your custom DLLs and custom reports have been copied to the new directory (<drive>:\Program Files\Deltek\Vision)).”
- The Installer renames the previous product installation directory by appending “OLD” to the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.”
- The Installer removes Deltek Vision 7.4 (or previous version) from Add/Remove Programs.

Report Tier

- The Installer attempts to detect previous tier installations (deployment model) and makes a recommendation about what you should select in the dialog boxes.
- A readme.txt file is inserted into the renamed folder, explaining that the original installation folder was renamed. On the report only tier, the folder may contain custom report images that must be moved to the new folder location.
- The Installer renames the previous product installation directory by appending “OLD” to the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.”
- The installer removes Deltek Vision 7.5 (or previous version) from Add/Remove Programs.
Web / Application Tier

- The Installer attempts to detect previous tier installations (deployment model) and makes a recommendation about what you should select in the dialog boxes.
- The Installer attempts to detect a previous installation directory.
  - The Installer copies the databases.enc and web.config files from the previous installation and uses them for the new installation.
  - The Installer applies applicable web.config changes detected from your old web.config file to the new installation (depending on the previous version from which it is upgrading).
- The Installer creates the deltekvision75.sql script file for upgrading the database only on the web/application server tier because the web.config file exists only on the web/application tier.
- The Installer attempts to detect the existing DeltekVisionAppPool and detects Vision and VisionClient IIS application/virtual directories. It keeps the existing application pool and virtual directory custom configuration changes.
  This step is performed because some environment configurations may use different Application Pool identities, non-standard AppPool or virtual directory settings, non-standard ports, SPNs, SharePoint, and so on.
- A readme.txt file is inserted into the renamed folder, containing the text: “This is a previously used Deltek Vision directory that is no longer used and can be safely removed after ensuring that all of your custom DLLs and custom reports have been copied to the new directory (<drive>:\Program Files\Deltek\Vision\).”
- The Installer uninstalls SQLXML 4.0 (SP2).
- The Installer uninstalls Solid Documents (COM) and replaces it with Solid Documents (.NET).
- The Installer renames the previous product installation directory by appending “OLD” to the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.”
- The Installer removes Deltek Vision 7.4 (or previous version) from Add/Remove Programs.

Process Server Tier

- Process Server is uninstalled from the previous installation directory and then installed using the new installation directory.
- Service Identity
  - New Installations
    - Set to local DeltekVision. Uses the default password for the account created by the installer and sets start up mode to Automatic.
  - Upgrades
    - Identity is configured with the Deltek Vision default account. If setup cannot validate the local account, it will prompt you to enter a password for the identity. You can enter the text bypass as a password if validation fails or if you do not want to set the password during installation. You must set the password on the Process Server service after the installation or the service will fail to start.
Identity is configured with a domain account. Setup prompts you to enter a password. You can enter the text **bypass** as a password if validation fails or if you do not want to set the password during installation. You must set the password on the Process Server service after the installation or the service will fail to start.

- If the Process Server identity is configured with a domain account and, when performing the upgrade, you are logged into the server using a domain account, when you are asked for the domain password for the Process Server service identity, the account validation will be performed successfully.
- If the Process Server is configured with a domain account and, when performing the upgrade, you are logged into the server using a local (non-domain) account, when you are asked for the domain password for the Process Server service identity, the account validation will fail, even when the credentials are entered correctly. To continue with the installation you must enter the text **bypass**. Then reset the password to the domain account password in the Services application after the installation is completed.
- Identity is configured with the Windows LocalSystem account. Setup sets the identity to use the LocalSystem account after the upgrade.
- The Installer sets the service start up mode to be the same as it was before the upgrade.

If you entered the text **bypass** so that the installer could continue without validating the Process Server service identity, after the installation is complete, you must set the password on the Process Server service identity or the service will fail to start.

- A readme.txt file is inserted into the renamed folder, containing the text:  “This is a previously used Deltek Vision directory that is no longer used and can be safely removed after ensuring that all of your custom DLLs and custom reports have been copied to the new directory (<drive>:\Program Files\Deltek\Vision)”.  
- The Installer renames the previous product installation directory by appending “OLD” to the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.”
- The Installer removes Deltek Vision 7.4 (or previous version) from Add/Remove Programs.

If you are performing a Process Server tier upgrade and had made any edits to the Deltek.Vision.ProcessServer.Server.exe.config file to customize Process Server behavior, such as the number of emails being sent at a time (EmailChunkSize) or the maximum size of an email (MaxEmailSize), log in to the application after the installation is completed and follow the steps in the Custom web.config Settings Migration section to ensure that they are applied. If they are not applied, apply them as needed.

**Considerations Prior to Upgrading**

If you are using a Sage Abra (formerly Best Software Abra) application stored in a FoxPro database, **do not upgrade** to Deltek Vision 7.6

Deltek Vision 7.6 is now running as a native 64-bit application and is unable to integrate with the Sage Abra database stored in a FoxPro database for the following reasons:
• Microsoft FoxPro ODBC/OLEDB drivers are only 32-bit.

Known Issues with the Vision 7.6 Installation

• In certain circumstances, the databases.enc entries for the Report Server Configuration tab are not being filled in. Check your database entries using Weblink, and test the database and Report Server configurations to ensure that they are accurate.
• If you are upgrading from a 6.x version of Vision and you use a Microsoft SQL Server Session State that is located in a database other than your Vision database, see KB article #72573 for additional instructions. During the Vision upgrade process, the SessionState table is renamed. However, if the table is not located in the Vision transaction database, it will not be renamed. You must manually rename the table using the instructions in the KB article.

If you encounter any problems with your installation, contact Deltek’s Global Services team at DGSConsultants-PES@deltek.com.

Upgrading from Version 5.1 or Earlier

• If you plan to upgrade your database during the installation, refer to the table in the Converting a Database During Installation section below.
• Vision 5.1 installations did not support the currently supported Windows Operating Systems, so all your deployment tiers will be run as a new installation.

Before uninstalling your previous version of Vision, ensure that your hardware and software meet the minimum requirements for running this current Vision release.

If you are using Vision 5.1 and have users connecting from the Internet outside of a Virtual Private Network (VPN), see the Deltek Vision Advanced Technical Administration Guide for advanced topics for configuring and securing connections to Vision.

Database Upgrades

• Vision database upgrades from Vision 6.x or 7.x are supported.
• If your database is older than version 6.x, a message will display during the installation, letting you know that there are no valid databases to convert. You must manually convert those databases to a minimum of version 6.0 and then upgrade to the current release. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0 and refer to the instructions in the following table for your installation.

See Converting a Database During Installation below for more information.

• Web Server installations create a deltekvision76.sql file in the \program files\Deltek\Vision\Databases\Scripts folder that you can use to manually upgrade the database to the current version.
To convert your database manually, create a backup of your database before you run the database conversion using the Deltekvision76.sql script file. Do not run UnicodeDeltekVision76.sql or other script files unless your database is Unicode. If you plan to convert your Vision database to Unicode, see the Vision online help for the appropriate steps.

Converting Vision 5.x or Earlier Databases

When completing the database portion of the installation process, Vision checks to see if there are any existing 6.x databases. If so, the Database to Upgrade screen displays. If you are migrating from a version prior to Vision 6.x, follow the steps listed in the table below on how to upgrade.

Database Migration Path Table

<table>
<thead>
<tr>
<th>Database Migration Path</th>
<th>Steps</th>
</tr>
</thead>
</table>
| 5.x to 6.x              | Log on to the Deltek Customer Care website.  
Select KB article # 43088, titled How to upgrade the Vision database.  
Download and run either the DeltekVision61SP4_upgradescripts.zip or DeltekVision61SP2_upgradescripts.zip conversion script to convert your database to version 6.x. |
| 4.x to 6.x              | Log on to the Deltek Customer Care website.  
1. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0.  
Download and run the DeltekVision50.sql conversion script to convert your database to version 5.x.  
2. Select KB article # 43088, titled How to upgrade the Vision database.  
Download and run either the DeltekVision61SP4_upgradescripts.zip or DeltekVision61SP2_upgradescripts.zip conversion script to convert your database to version 6.x. |
| 3.x to 6.x              | Log on to the Deltek Customer Care website.  
1. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0.  
   a. Download and run the DeltekVision41RTM.sql conversion script to convert your database to 4.x.  
   b. Download and run the DeltekVision50.sql conversion script to convert your database to version 5.x.  
2. Select KB article # 43088, titled How to upgrade the Vision database.  
Download and run either the DeltekVision61SP4_upgradescripts.zip or DeltekVision61SP2_upgradescripts.zip conversion script to convert your database to version 6.x. |
Pre-Installation Information

Custom Programming, Including Custom Invoices and Custom Reports

Before you upgrade to Vision 7.6:

- Review all existing custom work, including custom invoices and custom reports, at least eight weeks prior to your intended go-live date.
- Compare your custom work to the new functionality provided in this release.
- If this new version possesses the functionality contained in your custom work, these custom programs may no longer be needed. If the functionality contained in your custom work is not provided in this release, you must ensure the custom work remains intact through the upgrade process.
- Identify any hot fixes or patches that you plan to deploy with your Vision 7.6 upgrade. Ensure that, following the hot fix or patch deployment, you retain all custom functionality.
- Deltek strongly recommends that when you upgrade, you first deploy an instance of Vision 7.6 in your test environment. This allows for functional User Acceptance Testing (UAT) to ensure that all mission-critical custom features are still available to the user community. Typical deployments call for a 30–45 day test period before you upgrade Vision in your production environment.
- If you are upgrading to Vision 7.6 from a version earlier than Vision 6.0, and you have developed custom programming and/or reports in the earlier versions of Vision, all existing custom programming developed prior to the Vision 6.0 release must be rewritten in Smart Client.

Deltek’s Technical Services team is available to support you as you plan for this upgrade. We offer both technical and custom services. Contact DGCONSULTANTS-PES@Deltek.com.

Custom Database Objects

If you created any custom objects on your existing Vision database (including custom tables and custom triggers), you must review these objects before you upgrade to Vision 7.0 or later versions. If you have created custom triggers, you must turn them off before you begin the upgrade process because they might cause the upgrade to fail.

Vision Screen Designer

Screen design changes that you applied in versions earlier than Vision 6.0—using the Vision Screen Designer—may not display correctly in Vision 7.0 and later versions because Vision now uses different font and field sizes than those used in previous releases. Review any screens that you previously changed using the Screen Designer and modify them as needed.

Known Issues

If you use Internet Explorer and the Vision online help does not display correctly, you need to turn off Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display intranet sites in Compatibility View check box. Then refresh the browser. You could also elect to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this issue. Make sure you remove deltek.com (if listed) from the Websites you’ve added to Compatibility View list.
Important Notes about the Vision Installation

This section provides important information specific to the Vision 7.6 installation.

Setup Log File

If you encounter problems during the Vision installation and you are unable to continue with the installation on the server, contact Deltek Customer Care for assistance and include the information listed in the DeltekVisionSetupLog.txt file.

For security reasons, the temporary log file is stored in the C:\Users\%Username%\AppData\Local folder of the administrator performing the installation on the Vision server. To navigate to the file, an administrator can enter the environmental variable %LocalAppData% at a Run prompt or in the Windows Search Box on the server.

Microsoft SQL Server Express Edition

Vision 7.6 supports Microsoft SQL Server Express. If you are implementing SQL Server Express, Deltek recommends that you use the SQL Server 2014 SP1 Express edition with Advanced Services. The Express edition contains the Database Engine and Reporting Services that are required for managing the Vision database and running reports.


Microsoft SQL Server Reporting Services—Custom Reports and Custom Invoices

After you upgrade to Vision 7.6 from a 7.4 or earlier version, you must upgrade your existing custom reports and custom invoices to the supported RDL 2010 schema, which is now required.

For instructions on how to upgrade your custom reports and invoices to the RDL 2010 schema, see the “Custom Reports Created with Microsoft SQL Server Reporting Services Versions 2005 and 2008” section in the Deltek Vision 7.6 Custom Reports and Microsoft SQL Server Reporting Services Guide.

For an overview of the Microsoft SSRS report-writing tools that are supported in Vision 7.6, see the “Changes to Supported Environments and Technical Considerations that Are New for Vision 7.6” section on page 4 of these release notes.

Custom Report Business Objects

When you install the Vision 7.6 upgrade to your Vision server (web server tier), Vision 7.6 custom report business objects are installed into the <Deltek Vision Installation Directory>\Support\SDK folder. In this folder, extract the contents from the VBReporting.exe self-extracting file to access the custom report business objects.
Connect for Microsoft Outlook
This section applies if you are upgrading to Connect for Microsoft Outlook 7.6 from an earlier version. Connect for Microsoft Outlook and any updates to it are now included in the Vision 7.6 installation and Vision Cumulative updates on the web/application tier.

See the Deltek Vision 7.6 Connect for Microsoft Outlook Installation Guide for specific instructions for performing new and upgrade deployments.

Revenue Generation and Gains and Losses
This applies if you are upgrading from a Vision 6.x version to 7.6 and you use all of the following in Vision:

- Revenue Generation
- Revenue categories for Revenue Generation
- Multiple currencies

Before you run Revenue Generation in 7.6, be sure that you have specified a different unbilled service account for each revenue category on the Revenue tab in Configuration » Accounting » Company Settings.

In Vision 6.x versions, you were not required to have different unbilled service accounts, but in 7.x versions, you must have a different unbilled service account for each revenue category. If you have the same account for multiple revenue categories in Vision 7.6, gains and losses adjustments are calculated automatically whenever Revenue Generation is processed, even when exchange rates have not changed and no new transactions have been posted to a project.

After you change an unbilled service account for revenue categories, the next time that you run Revenue Generation, you will see a one-time swing in revenue gains/losses to update the new unbilled service account.

Export Reports as Files
The new Export Reports as Files options allow you to save reports, including invoices, on the Vision application server or a server of your choice.

If you want to allow reports to be exported to the application server, you can choose from the following options on the Miscellaneous Tab in General System Settings (Configuration » General » System Settings):

- **Allow Reports to be Exported to Application Server**: Select this option to export reports to a file on the application server. The export process occurs when you select the Export Reports as Files When Printing option on the Print Setup dialog box. On this dialog box, you define the format for saving the report. For example, you might want to save an invoice file on the application server when the invoice is final printed but not when the draft invoice is created.

- **Allow Reports to be Uploaded via SFTP**: Select this option to use Secure File Transfer Protocol (SFTP) to export and save invoices to an application server of your choice. When you choose to upload via SFTP, Vision enables options so that you can specify the SFTP Host Name, User Name, and Password to ensure that your files are securely transferred to the appropriate location. The export process occurs when you select the Upload Reports via SFTP when Printing option on the Printer dialog box. On this dialog box, you can define the format for saving the report. For example, for Billing
Invoices you might want to save an invoice file on the application server when the invoice is final printed but not when the draft invoice is created.
Download and Install Vision 7.6

See the Deltek Vision 7.6 Technical Installation Guide for instructions on how to download and install or upgrade the Vision software. You can also refer to the Deltek Product Support Compatibility Matrix for more information about supported and non-supported environments. Download these guides from the Deltek Customer Care Connect site.

Upgrade Considerations

Deltek encourages clients to upgrade to the latest version of Vision because:

- New features are added only to the latest version.
- Except in critical situations, Deltek fixes software issues only in the latest version.
- Deltek support is typically available only for the latest and the next previous versions.
- The latest version incorporates the newest technologies and tools.

Before you upgrade, you should first review these release notes and perform a test conversion and test installation of the new version to ensure that your firm’s business processes are working properly in the new version.

After you upgrade to Vision 7.6, Deltek recommends that you run the Microsoft SQL Server Update Statistics maintenance program using the default option that uses a sample of the data. This is especially important for larger Vision databases, to help prevent performance issues.

If you are upgrading to Vision 7.6 from a version earlier than Vision 6.1, see the 6.1 release notes. You can download them from the Deltek Customer Care Connect site. You can also download copies of the prior versions of the Vision documentation at the Deltek Customer Connect site.

Deltek’s Global Services team is available to support you as you plan for an upgrade. They offer both technical and custom services to ensure the best possible Deltek experience. Contact DGSConsultants-PES@deltek.com.
Deploy Vision 7.6 on Client Workstations

The switch to Smart Client technology beginning with Vision 6.0 requires that compiled application code be stored on each user’s PC. ClickOnce is the Microsoft technology used to install this code without requiring that IT manually install Vision on each user’s machine. The code is downloaded automatically when Vision is opened on the user’s PC.

You must manually install .NET 4.5.2 on each workstation on which Vision 7.6 will be run.

Each time that you open Vision, the application automatically checks the server for any changes, such as a hot fix or a version upgrade. If no change is detected, Vision opens. If software updates are available (and they have been pushed out by your IT department) the updates are downloaded automatically.

When you open Vision 7.6 for the first time:

1. When the Deltek Vision launch page displays, click Run on this page to continue. Vision downloads the files required to open the Login screen.

2. On the Deltek Vision Login screen, enter your Username and Password, select a Database, and click Login.

   Vision downloads a zip file to your workstation (an Application Downloader dialog box displays during this process). This zip file is extracted into the local ClickOnce cache on your workstation. This is similar to the way that temporary Internet files are stored for browser applications.

   After the zip file is extracted, the Vision application opens and you can start working.

Subsequent Logins

On subsequent logins, assuming that no software updates have been received from Deltek, the Vision application opens on your workstation when you log in—no download will be necessary. When Deltek provides a new version of the software, or a hot fix, and your IT administrator installs the new version or hot fix, Vision will detect and download the update automatically when you log in.
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

This section identifies software issues that were resolved in Vision 7.6. It includes the issues that were fixed after the 7.5 release that were not fixed in the 7.5 cumulative updates (7.5 CUs).

The issues that were resolved in the 7.5 cumulative updates are also resolved in the 7.5 release. These resolved issues are described in “Appendix A: Software Issues Resolved and Enhancements in Vision 7.5 Cumulative Updates,” where they are organized by cumulative update number and date.

Whether you installed one or more of the 7.5 cumulative updates, or you moved directly to the latest release without installing any of the 7.5 cumulative updates, all of the issues described in this section and Appendix A have been resolved.

Accounting

Accounts Payable » Vendor Review

Defect 392387: When an AP check was voided and re-processed using a lower check number, Vendor Review still displayed the voided check number.

Customers Impacted: This defect applies to Vision 7.6.

Workaround Before Fix: None.

Additional Notes: A check number that was lower than the voided number would be unusual.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 469968: After you entered an AP Voucher in Transaction Entry and posted it, if you opened the voucher using Voucher Lookup on the toolbar of the AP Vouchers Transaction Entry form and changed the method in the Payment field, the change was not reflected in Accounting » Accounts Payable » Vendor Review as it should have been.

Customers Impacted: This defect applies to Vision 7.3–7.5.

Workaround Before Fix: Instead of changing the payment method in Transaction Entry, change the payment method and date in Vendor Review.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
Credit Card » Credit Card Reconciliation

**Defect 549515:** It took several minutes to open a credit card reconciliation statement. It also took a long time for data to populate the screen when you selected All Charges on the Charges tab in Credit Card Reconciliation.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 550668:** The cash-only journal entry that was created in Credit Card Reconciliation was not considering cash-basis mapping for the account that was used in the original transaction.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** Manually enter a cash-only journal entry after posting to move expenses to the desired cash basis account. Or, manually edit the transaction file before posting.

**Additional Notes:** None.

**Files Updated**

**Deltek.Vision.CreditCardReconciliation.Server.dll**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

Accounting » Intercompany Billing

**Defect 564101:** In Intercompany Billing, you received a "FrameworkException: SQL Reporting Error creating ICHeader RDL file" error when you previewed an invoice if the invoice template for the invoice had the following settings entered on the Totals tab of the Invoice Template Editor form in Billing » Invoice Template Editor:

- The Print Total in Invoice Header check box was selected.
- In the field below the Print Total in Invoice Header check box, Total Now Due was selected.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** On the Totals tab of the Invoice Template Editor form, select Invoice Total instead of Total Due Now in the field below the Printing Total in Invoice Header check box.

**Additional Notes:** None.

**Files Updated**

**Deltek.Vision.ReportingInvoice.Server.dll**
Other Applications Affected
Database Changes
System File Dependencies

**Accounting » Void Check**

**Defect 554502:** In the Void Check application, you could not void an uncleared check when the vendor's EFT account status was set to **Add** on the Accounting tab in the Vendor Info Center. Vision incorrectly treated the uncleared regular check as an EFT payment.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**

Database Changes
System File Dependencies

**Analysis Cubes**

**Defect 577897:** There was a performance issue that occurred when Analysis Cubes were refreshed that resulted in the application hanging when Planning data was loaded.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

Other Applications Affected
Database Changes
System File Dependencies

**Architecture**

**Defect 392736:** There was an issue where maximizing the width of a grid column and then pinning the column caused the other columns on the grid to be inaccessible. Now, the maximum width of a pinned column is limited to be slightly smaller than the width of the grid to allow access to the other columns.

**Customers Impacted:** This defect applies to Vision 7.6.

**Workaround Before Fix:** There is a script that you can apply to delete the settings. Contact Deltek Support for further information.
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Billing

Batch Billing

Defect 524854: When a draft run was scheduled in Billing » Batch Billing, the Previously Run tab did not refresh to show the updated run batch even though it displayed as “done” in Utilities » Process Server » Process Queue Manager. You had to exit out of Batch Billing for the batch to update on the Previously Run tab.

Customers Impacted: This defect applies to Vision 7.6.

Workaround Before Fix: Exit and reopen the application.

Additional Notes: None.

Files Updated


Other Applications Affected

Database Changes

System File Dependencies

Interactive Billing

Defect 552894: The following issue occurred if you set up your Windows desktop to use a comma as the decimal separator (in the Region and Language section of the Windows Control Panel). When you selected Invoice » View Supporting Documents on the Interactive Billing toolbar and you selected a supporting document (on the Supporting Documents dialog box) that included amounts that required a decimal separator, you received an error message.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: On the Expense or Units tabs in Interactive Billing, click the document icon in the Document column in the grid for the supporting document that you want to view. Then click the View option.

Additional Notes: None.

Files Updated


Other Applications Affected

Database Changes

System File Dependencies
Configuration

Accounting

Defect 550585: This issue applies if you use the Multicompany feature in Vision. When you set up a cash flow statement in Configuration » Accounting » Cash Flow Statement, you received an "Account range already exists for label <xxx>" message when you entered accounts in the Start Account and End Account fields on the Cash Flow Statement Setup tab. This occurred if the label that you entered in the Label field on this tab for a Cash Flow Statement subsection was already entered as the label for a subsection for another company.

Customers Impacted: This defect applies if you use the Multicompany feature in Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Organization

Defect 573040: The internal value for EmployeeCompany table was not set correctly when Organizations were enabled but Multicompany was not. This caused an error if a timesheet was selected in Time & Expense » Timesheets.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
Security » Roles

Defect 568628: When the Functional Area on the Access Rights tab in Configuration » Security » Roles was set to Lookups, the Employee Lookup option was listed multiple times on the Lookup Type drop-down.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Workflow » User Initiated Workflows

Defect 559757: A (401) Unauthorized error displayed when a Web Service was created and called from a User Initiated Workflow that was generated in Configuration » Workflow. This occurred when the PR.Status status changed in the Project Info Center.

Customers Impacted: This defect applies to Vision 7.4.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Dashboard

Defect 443012: After removing a field from the Selected Fields column for a Project Dashpart on the Dashboard, the field continued to display on the dashpart after the screen was refreshed.

Customers Impacted: This defect applies to Vision 7.6.
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Human Resources

Payroll

Defect 442574: The Subject and Message in an email for Payroll Remittance incorrectly displayed as the field name for the payment number and payment date [:Payment Number] [:Payment Date].

Customers Impacted: This defect applies to Vision 7.3 - 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Info Center

Defect 394376: The scroll bar on the Memo field in the Vision Text Editor did not work in the Project Info Center when the Security Role had Read Only access to Projects (Configuration » Security » Roles » Record Access) or the field was locked for the role.

Customers Impacted: This defect applies to Vision 7.1 and later versions.

Workaround Before Fix: Open the memo in "Review" to see the entire memo.

Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

**Defect 555086:** In a User Defined Info Center, a Standard search did not work when a **Memo** field was used as the search criteria. However, there were no issues when the same criteria was applied in an Advanced search.

**Customers Impacted:** This defect applies to Vision 7.1 – 7.5.

**Workaround Before Fix:** Use an Advanced search instead of a Standard search.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

Database Changes

System File Dependencies

**Defect 581041:** When conducting a Quick Find, Vision did not search for every record that contained the string of characters that was entered. Instead, it only loaded the first record.

**Customers Impacted:** This defect applies to Vision 6.1 and later versions.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

Database Changes

System File Dependencies
Employees

Defect 575254: If you hid the **Social Security Number** field in the Employee Info Center using Screen Designer, when you tried to save an employee record that had a social security number already entered for it, you received the following error message "Social Security Number must contain data in order to use EFT Payroll Remittance function."

Customers Impacted:

Workaround Before Fix: Do not hide the **Social Security Number** field.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 584184: When using a Multicompany database, an error occurred if you used the Email » Email Active Group option to send a broadcast email in the Employee Info Center.

Customers Impacted: This defect applies to Vision 7.6.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated


Other Applications Affected

Database Changes

System File Dependencies

Vendors

Defect 342175: When you tried to add a new vendor in the Vendor Info Center, you received a "Vendor <xxxxx> already exists" message even when the vendor did **not** already exist. This occurred when all of the following applied:
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

- An employee in the Employee Info Center had the same number as the number you entered for the vendor.
- The employee with the same number had entered an expense item on an expense report that had been invoiced to a client.
- In Vision, the employee number and vendor number were set up with the same formatting (same length, delimiter, delimiter position, and so on).

**Customers Impacted:** This defect applies to Vision 7.0–7.5.

**Workaround Before Fix:** Use a different number for the vendor.

**Additional Notes:** None.

**Files Updated**
- sp_VendorInTables.SQL

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Planning**

**Defect 544528:** When the Match JTD setting on the Default WBS Mapping dialog was set to the Phase or Task level, the actual overhead cost on the Analysis tab was calculated incorrectly. This resulted in inconsistent data between the Analysis tab in Planning and Project Review.

**Customers Impacted:** This defect applies to Vision 7.6.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 555347:** There was slow performance when retrieving a plan. This was caused by issues with determining how unplanned resources were charged to the plan or project.

**Customers Impacted:** This defect applies to Vision 7.5.
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

Workaround Before Fix: None.
Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Proposals

Defect 412103: When you merged a custom proposal that was created with Adobe InDesign, if it had a project record and a graphic code from the project record, the image came across stretched to its original resolution. It should not have been stretched.
Customers Impacted: This defect applies to Vision 7.1–7.5.
Workaround Before Fix: Manually adjust the images.
Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Purchasing

Defect 463633: In Purchase Orders, when you used the Print option on the toolbar, some of the purchase order text that should have printed on the first page started printing on the second page in either of the following situations:

- You downloaded a purchase order to a .pdf file
- You previewed a purchase order using the Print Layout icon in the previewed purchase order.

Customers Impacted: This defect applies to Vision 7.3–7.5.
Workaround Before Fix: None.
Additional Notes: None.
Defect 384816: When the Include Payment Transactions option was selected on the General tab of the Gains, Losses and Revaluations report, Payment Transactions were not included on the report.

Customers Impacted: This defect applies to Vision 7.6.

Workaround Before Fix: None.

Additional Notes: None.

Defect 550585: This issue applies if you use the Multicompany feature in Vision. When you set up a cash flow statement in Configuration » Accounting » Cash Flow Statement, you received an "Account range already exists for label <xxx>" message when you entered accounts in the Start Account and End Account fields on the Cash Flow Statement Setup tab. This occurred if the label that you entered in the Label field on this tab for a Cash Flow Statement subsection was already entered as the label for a subsection for another company.

Customers Impacted: This defect applies if you use the Multicompany feature in Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 551237: When you tried to download the Tax Analysis report to Microsoft Excel, it failed sometimes if there was a large amount of data in the report. This was related to the contents of the document map for the report, which should have included only the fields that you selected for sorting and grouping, but it was erroneously including all the columns added to the report. (You open the document map for a report by clicking the pointer in the thin bar on the left side of the previewed report.)

Customers Impacted: This defect applies to Vision 7.2–7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Tax Analysis.rdl

Other Applications Affected

Database Changes

System File Dependencies

Defect 568869: The following amounts for non-recoverable tax codes on the Tax Analysis report were calculated incorrectly:

- The Net Amount Tax Basis and Gross Amount were doubled.
- The Recoverable and Non-Recoverable Tax was four times the correct amount.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected
Database Changes

System File Dependencies

Defect 501372: This issue applies if you log into Vision using the Portuguese (Brazil) language. For the Payment Register report, you received an error when you selected a date range on the General tab of the Payment Register Options dialog box.

Customers Impacted: This defect applies if you use the Portuguese (Brazil) language in Vision 7.2–7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Configuration

Defect 550951: The Role Summary report (Reporting » Configuration) generated an error message when attempting to Print or Preview.

Customers Impacted: This defect applies to Vision 7.2 and later versions.

Workaround Before Fix: Update SEReportColumns Set ReportType = 'Employee Labor ADT' Where ReportType = 'Employee Labor Audit' And ReportFolder = 'Employee'

Additional Notes: None.

Files Updated

Employee Labor ADT.rdl

Other Applications Affected

Database Changes

System File Dependencies

Consolidated GL

Defect 267059: In Reporting » Consolidated GL, the Consolidated Income Statement report produced a dataset error when the following settings were applied to the Options dialog box:
On the General tab, a consolidation group was selected in the **Consolidation Group Lookup** field and a budget is selected in the **Year/Budget Name** grid.

On the Columns tab, a calculation column was added that used an Organization Level 1 option in the **Field** grid as a calculation condition in the Add Calculated Field or Modify Calculated Field dialog box. Note that the **Field** grid displays options based on the user interface label instead of the system label. Go to the Label column in the Labels tab of **Configuration » General » System Setting** to know the user interface label for the Organization Level 1 system label. The user interface label is based on your firm’s preference.

**Customers Impacted:** This defect applies to Vision 7.6.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Contact**

**Defect 394181:** The Contact Summary report displayed the Opportunity ID instead of the Opportunity Number.

**Customers Impacted:** This defect applies to Vision 7.6.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Employee**

**Defect 254375:** When using an Advanced Search while running the Employee Ledger Report with detail, not all detail data was shown. For example, reports with detail lines that included subreports did not display any detail.
Customers Impacted: This defect applies to Vision 7.6.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 501118: When an Employee Info Center included Custom Grids (Configuration » General » User Defined Components), limiting the columns on the Employee List report caused the user-defined grid to no longer be available on the report.
Customers Impacted: This defect applies to Vision 7.6.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Opportunity

Defect 486516: When running the Opportunity List report, the header line displayed when the Header option was not checked but the Show Totals on Header Line option was checked.
Customers Impacted: This defect applies to Vision 7.6.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes
System File Dependencies

**Project**

**Defect 522779**: The Project Detail report showed an html code error when more than 1500 characters were used in the Description field.

**Customers Impacted**: This defect applies to Vision 7.6.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

Other Applications Affected

Database Changes

System File Dependencies

**Defect 583915**: The Labor Category that printed on the Project Labor Detail report was incorrect. Vision applied the labor category from the Employee Info Center instead of the labor category from the timesheet.

**Customers Impacted**: This defect applies to Vision 7.6.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

Other Applications Affected

Database Changes

System File Dependencies

**Purchasing**

**Defect 581984**: For the Received Purchase Order Items report, the HTML Formatting check box for the Receive Notes column was not accessible in the grid on the Columns tab of the Received
Purchase Order Items Option dialog box. If you included the Receive Notes column on the report, the received notes printed on the report with HTML formatting. You were unable to turn off the HTML formatting.

**Customers Impacted:** This defect applies to Vision 7.3–7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Time and Expense**

**Expense Report**

**Defect 549513:** In Expense Reports, the taxes that should have been calculated for an expense report line item were not calculated in the following circumstance:

1. In Expense Reports, open an in-progress expense report for employee A that has multiple expense line items entered in the expense item grid.
2. For one of the expense line items, change the entry in Category field.
3. Click Open on the Expense Reports toolbar to open an in-progress expense report for employee B.
4. In the dialog box that asks if you want to save the changes for employee A's expense report, click No.
5. Select an expense report for employee B that already has an expense line item with an expense category that has more than one tax code assigned to it.
6. Change the entry in the Category field for the expense line item that has more than one tax code assigned to it.
   When you move off the Category field, taxes are recalculated to have a zero amount.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** In this scenario, after you make a change to the first expense report, exit the Expense Report application. In the dialog box that asks if you want to save the changes for the expense report, click No. Then reopen the Expense Report application and open the second expense report to make changes to it.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**
Software Issues Resolved in Vision 7.6 Since the Vision 7.5 Release

Database Changes

System File Dependencies

**Timesheet**

**Defect 389369:** A unit table automatically populated on a timesheet even though the associated project had no unit table defined.

**Customers Impacted:** This defect applies to Vision 7.6.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 586513:** This issue only applied when a user's access rights allowed them to log into a company other than their active company (for example, the user had System level Timesheet access). When reviewing the time entry on the Floor Check dialog, attempting to send an email alert using the **Send Email** option resulted in an error.

**Customers Impacted:** This defect applies to Vision 7.6.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Transaction Center » Transaction Lists and Posting Logs

Defect 596371: This applies if you have tax auditing enabled. When you entered an expense report, AP voucher, AP disbursement, cash disbursement, or journal entry in Transaction Entry and posted it, the posting log did not show the specific amounts for the line item. However, it showed the correct amounts for the general ledger accounts in the summary section of the posting log. This occurred if the first row in the Tax Codes grid on the Tax Codes dialog box in Transaction Entry was empty, and you entered the tax for the line item in the second row in the grid.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: Do not insert a blank line in the Tax codes grid on the Tax Codes dialog box.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Utilities

Process Server

Defect 364479: Vision did not process scheduled emails for direct deposit advices.

Customers Impacted: This defect applies to Vision 7.0 and later versions.

Workaround Before Fix: Send the email advices manually.

Additional Notes: None.

Files Updated

Deltek.Framework.SysEmail.Server.dll

Other Applications Affected

Database Changes

System File Dependencies
Database Changes

This section lists the database table and column changes included in this release.

Deltek creates the Vision Data Dictionary using a live connection to the Vision development database. Tables and columns related to features in a future release may appear in the data dictionary without descriptions, or with the phrase reserved for future use. You may also see tables and columns for features that you have not purchased or enabled.

New Tables

<table>
<thead>
<tr>
<th>Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFGCurrencyDownloadCode</td>
</tr>
<tr>
<td>CFGEKStatusData</td>
</tr>
<tr>
<td>CFGEKStatusDescriptions</td>
</tr>
<tr>
<td>FW_Attachments</td>
</tr>
<tr>
<td>FW_CFGAttachmentCategoryData</td>
</tr>
<tr>
<td>FW_CFGAttachmentCategoryDesc</td>
</tr>
<tr>
<td>IQItem</td>
</tr>
<tr>
<td>UNDocuments</td>
</tr>
<tr>
<td>UNDocumentsDetail</td>
</tr>
<tr>
<td>UPDocuments</td>
</tr>
<tr>
<td>UPDocumentsDetail</td>
</tr>
</tbody>
</table>

Removed Tables

<table>
<thead>
<tr>
<th>Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFGOurRoleData</td>
</tr>
<tr>
<td>CFGOurRoleDescriptions</td>
</tr>
</tbody>
</table>
## New Columns in Existing Tables

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Column Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApprovalItem</td>
<td>ApprovalLevel</td>
<td>varchar(10) NOT NULL default ('Master')</td>
</tr>
<tr>
<td>ApprovalItem</td>
<td>ApproveItemApplicationKeyIDX</td>
<td>Index</td>
</tr>
<tr>
<td>ApprovalItem</td>
<td>StashStatusCode</td>
<td>varchar(10)</td>
</tr>
<tr>
<td>ApprovalWorkflow</td>
<td>ApprovalLevel</td>
<td>varchar(10) NOT NULL default ('Master')</td>
</tr>
<tr>
<td>BILD</td>
<td>TLInternalKey</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>BILD</td>
<td>TLProcessed</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>billConDetail</td>
<td>RateFlag</td>
<td>varchar(1)</td>
</tr>
<tr>
<td>billExpDetail</td>
<td>RateFlag</td>
<td>varchar(1)</td>
</tr>
<tr>
<td>billLabDetail</td>
<td>BackupEmpName</td>
<td>varchar(100)</td>
</tr>
<tr>
<td>billLabDetail</td>
<td>EmpName</td>
<td>varchar(100)</td>
</tr>
<tr>
<td>billUnitDetail</td>
<td>RateFlag</td>
<td>varchar(1)</td>
</tr>
<tr>
<td>BT</td>
<td>BackupAddOns</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BT</td>
<td>BackupEmpTitle</td>
<td>smallint NOT NULL default (0)</td>
</tr>
<tr>
<td>BT</td>
<td>BackupEmpTitleTable</td>
<td>int NOT NULL default (0)</td>
</tr>
<tr>
<td>BT</td>
<td>BackupExpDefault</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BT</td>
<td>BackupFees</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BT</td>
<td>EmpTitle</td>
<td>smallint NOT NULL default (0)</td>
</tr>
<tr>
<td>BT</td>
<td>EmpTitleTable</td>
<td>int NOT NULL default (0)</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>BT</td>
<td>SupportDocumentsUN</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>BackupAddOns</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>BackupEmpTitle</td>
<td>smallint NOT NULL default (0)</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>BackupEmpTitleTable</td>
<td>int NOT NULL default (0)</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>BackupExpDefault</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>BackupFees</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>EmpTitle</td>
<td>smallint NOT NULL default (0)</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>EmpTitleTable</td>
<td>int NOT NULL default (0)</td>
</tr>
<tr>
<td>BTDefaults</td>
<td>SupportDocumentsUN</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGAccrualScheduleDetail</td>
<td>HoursPerHourWorked</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>CFGAccrualScheduleDetail</td>
<td>MaxHoursPerProcess</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>CFGAccrualScheduleMasterD ata</td>
<td>BasedOnHoursWorked</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGApprovalType</td>
<td>AllowUnSubmit</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGApprovalType</td>
<td>ApprovalLevel</td>
<td>varchar(10) NOT NULL default ('Master')</td>
</tr>
<tr>
<td>CFGApprovalType</td>
<td>AutoApproveDetailLines</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGApprovalType</td>
<td>ConcurrentApprovals</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGCreditCard</td>
<td>EmployeePaid</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>CFGCreditCard</td>
<td>MapToDescription</td>
<td>varchar(1)</td>
</tr>
<tr>
<td>CFGCreditCardImportDetailData</td>
<td>DisplayInReconciliation</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGCurrencyDownloadLicense</td>
<td>LicensePassword</td>
<td>varchar(150)</td>
</tr>
<tr>
<td>CFGEKMain</td>
<td>UseApprovalWorkflow</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGEKMain</td>
<td>Workflow_UID</td>
<td>varchar(32)</td>
</tr>
<tr>
<td>CFGEMail</td>
<td>DisposeMailSender</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGIntegrationWS</td>
<td>LastReceiveProjects</td>
<td>datetime</td>
</tr>
<tr>
<td>CFGIntegrationWS</td>
<td>LastReceiveTimesheets</td>
<td>datetime</td>
</tr>
<tr>
<td>CFGIntegrationWS</td>
<td>LastSyncFields</td>
<td>datetime</td>
</tr>
<tr>
<td>CFGMainData</td>
<td>AccrueBasedOnHoursWorked</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGMainData</td>
<td>AccrueExcludeOvertimeHours</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGMainData</td>
<td>AccrueMinimumHours</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>CFGMainData</td>
<td>AccrueNotLessThanMinimumHours</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGMainData</td>
<td>PrintEXBankAccount</td>
<td>varchar(1) NOT NULL default ('Y')</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel01</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel02</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel03</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel04</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel05</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel06</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel07</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel08</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel09</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPOMain</td>
<td>VendorResponseLabel10</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>CFGPostControl</td>
<td>AccrualOnHourWorkedStatus</td>
<td>varchar(1)</td>
</tr>
<tr>
<td>CFGPYAccrualsData</td>
<td>WBS1ExcludeWhere</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>CFRGRMSets</td>
<td>HardBooked</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFRGRMSets</td>
<td>JTDDate</td>
<td>datetime</td>
</tr>
<tr>
<td>CFGVisionSystem</td>
<td>IQAllowWorkflows</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CFGVisionSystem</td>
<td>IQIgnoreRequiredFields</td>
<td>varchar(1) NOT NULL default ('Y')</td>
</tr>
<tr>
<td>CFGVisionSystem</td>
<td>IQLastUpdate</td>
<td>datetime</td>
</tr>
<tr>
<td>CFGVisionSystem</td>
<td>IQRetryCount</td>
<td>smallint NOT NULL default (0)</td>
</tr>
<tr>
<td>CFGVisionSystem</td>
<td>IQScheduleTime</td>
<td>datetime</td>
</tr>
<tr>
<td>CFGVisionSystem</td>
<td>IQUpdateCRMOpportunities</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>CL</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>Contacts</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>CreditCardTransaction</td>
<td>PersonalCharge</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>ekDetail</td>
<td>EKDetailCCardPKeySortOrderDescrDX</td>
<td>Index</td>
</tr>
<tr>
<td>EMAccrual</td>
<td>HoursPerHourWorked</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>EMAccrual</td>
<td>HoursWorked</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>EMAccrual</td>
<td>MaxHoursPerProcess</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>EMAccrualDetail</td>
<td>HoursWorked</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>EMINitiation</td>
<td>ProfessionalSuffix</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>EMINitiation</td>
<td>TalentModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>EMINitiation</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>EMMMain</td>
<td>ProfessionalSuffix</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>EMMMain</td>
<td>TalentModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>EMMMain</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>FileSizeUploadLimit</td>
<td>int NOT NULL default (50)</td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>WAADAuthType</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>WAADClientID</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>WAADServerClientID</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>WAADServerClientSecret</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>WAADTenant</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>ItemRequestMaster</td>
<td>TotalAmount</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>LD</td>
<td>TLInternalKey</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>LD</td>
<td>TLProcessed</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>LedgerEX</td>
<td>LedgerEXCreditCardPKeyIDX</td>
<td>Index</td>
</tr>
<tr>
<td>Opportunity</td>
<td>BusinessDeveloperLead</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>Opportunity</td>
<td>IQLastUpdate</td>
<td>datetime</td>
</tr>
<tr>
<td>Opportunity</td>
<td>MarketingCoordinator</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>Opportunity</td>
<td>ProposalManager</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POMaster</td>
<td>POInternalNotes</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POMaster</td>
<td>TotalNetAmount</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>POMaster</td>
<td>TotalNotToExceed</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response01ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response02ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response03ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response04ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response05ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response06ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response07ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response08ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response09ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>Response10ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse01</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse02</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse03</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse04</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse05</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse06</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse07</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse08</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse09</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponse10</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPQVendorDetail</td>
<td>VendorResponseApplyToAllItems</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>POPRMaster</td>
<td>TotalAmount</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response01ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response02ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response03ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response04ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response05ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response06ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response07ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response08ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response09ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>Response10ModUser</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse01</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse02</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse03</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse04</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse05</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse06</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse07</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse08</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse09</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponse10</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>POPRVendorDetail</td>
<td>VendorResponseApplyToAllItems</td>
<td>varchar(1) NOT NULL default ('N')</td>
</tr>
<tr>
<td>PR</td>
<td>TLChargeBandExternalCode</td>
<td>varchar(14)</td>
</tr>
<tr>
<td>PR</td>
<td>TLChargeBandInternalKey</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>PR</td>
<td>TLProjectID</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>PR</td>
<td>TLProjectName</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>PR</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>TLChargeBandExternalCode</td>
<td>varchar(14)</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>Data Type</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>TLChargeBandInternalKey</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>TLProjectID</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>TLProjectName</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>TLChargeBandExternalCode</td>
<td>varchar(14)</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>TLChargeBandInternalKey</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>TLProjectID</td>
<td>varchar(40)</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>TLProjectName</td>
<td>varchar(255)</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>TLSyncModDate</td>
<td>datetime</td>
</tr>
<tr>
<td>PYChecksA</td>
<td>HoursWorked</td>
<td>decimal(19,4) NOT NULL default (0)</td>
</tr>
<tr>
<td>RPAssignment</td>
<td>HardBooked</td>
<td>varchar(1) NOT NULL default (‘N’)</td>
</tr>
<tr>
<td>RPTask</td>
<td>Notes</td>
<td>varchar(max)</td>
</tr>
<tr>
<td>SETransTypes</td>
<td>Company</td>
<td>varchar(14) NOT NULL</td>
</tr>
<tr>
<td>SETransTypes</td>
<td>Entry</td>
<td>varchar(1) NOT NULL default (‘N’)</td>
</tr>
<tr>
<td>SETransTypes</td>
<td>Lists</td>
<td>varchar(1) NOT NULL default (‘N’)</td>
</tr>
<tr>
<td>SETransTypes</td>
<td>PKey</td>
<td>varchar(32) NOT NULL default (left(replace(newid(),’-',''),(32))</td>
</tr>
<tr>
<td>SETransTypes</td>
<td>Post</td>
<td>varchar(1) NOT NULL default (‘N’)</td>
</tr>
<tr>
<td>SETransTypes</td>
<td>SETransTypesRoleTransTypeCompany_IDX</td>
<td>Index</td>
</tr>
<tr>
<td>tsDetail</td>
<td>TLInternalKey</td>
<td>varchar(40)</td>
</tr>
</tbody>
</table>
### Removed Columns from Existing Tables

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Column Name</th>
<th>New Data Type</th>
<th>Old Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEKGroups</td>
<td>AllowApproval</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>EMInitiation</td>
<td>EKAdminApproval</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>EMMain</td>
<td>EKAdminApproval</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>ApprovedByPrincipalEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>ApprovedByProjectManagerEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>ApprovedBySupervisorEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>DefaultOverheadEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>DefaultPromotionalEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>DefaultRegularEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>LineItemApprovalEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
<tr>
<td>FW_CFGSystem</td>
<td>RequireLineItemApprToPostEK</td>
<td>varchar(1) NOT NULL default ('N')</td>
<td></td>
</tr>
</tbody>
</table>

### Columns Changed in Existing Tables

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Column Name</th>
<th>New Data Type</th>
<th>Old Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApprovalItem</td>
<td>ApplicationKey</td>
<td>varchar(255) NOT NULL</td>
<td>varchar(32) NOT NULL</td>
</tr>
<tr>
<td>ApprovalItem</td>
<td>Comments</td>
<td>varchar(500)</td>
<td>varchar(120)</td>
</tr>
<tr>
<td>ApprovalItemHistory</td>
<td>Comments</td>
<td>varchar(500)</td>
<td>varchar(120)</td>
</tr>
<tr>
<td>CFGPRResponsibilityData</td>
<td>Code</td>
<td>varchar(20) NOT NULL</td>
<td>varchar(10) NOT NULL</td>
</tr>
<tr>
<td>Table Name</td>
<td>Column Name</td>
<td>New Data Type</td>
<td>Old Data Type</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------</td>
<td>---------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>CFGPRResponsibilityDescriptions</td>
<td>Code</td>
<td>varchar(20) NOT NULL</td>
<td>varchar(10) NOT NULL</td>
</tr>
<tr>
<td>CFGPRResponsibilityDescriptions</td>
<td>Description</td>
<td>varchar(80) NOT NULL</td>
<td>varchar(50) NOT NULL</td>
</tr>
<tr>
<td>CFGRMSettings</td>
<td>EmpUtilPercent</td>
<td>smallint NOT NULL default (105)</td>
<td>smallint NOT NULL default (100)</td>
</tr>
<tr>
<td>CFGRMSettings</td>
<td>OverSchPercent</td>
<td>smallint NOT NULL default (105)</td>
<td>smallint NOT NULL default (100)</td>
</tr>
<tr>
<td>CFGRMSettings</td>
<td>UnderSchPercent</td>
<td>smallint NOT NULL default (95)</td>
<td>smallint NOT NULL default (0)</td>
</tr>
<tr>
<td>CFGRMSettings</td>
<td>UnderUtilPercent</td>
<td>smallint NOT NULL default (95)</td>
<td>smallint NOT NULL default (100)</td>
</tr>
<tr>
<td>FW_CustomColumnValuesData</td>
<td>DataValue</td>
<td>varchar(255) NOT NULL</td>
<td>varchar(100) NOT NULL</td>
</tr>
<tr>
<td>FW_Files</td>
<td>ContentType</td>
<td>varchar(200) NOT NULL</td>
<td>varchar(50) NOT NULL</td>
</tr>
<tr>
<td>Opportunity</td>
<td>OurRole</td>
<td>varchar(20)</td>
<td>varchar(15)</td>
</tr>
<tr>
<td>PR</td>
<td>OurRole</td>
<td>varchar(20)</td>
<td>varchar(15)</td>
</tr>
<tr>
<td>PR</td>
<td>Responsibility</td>
<td>varchar(20)</td>
<td>varchar(10)</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>OurRole</td>
<td>varchar(20)</td>
<td>varchar(15)</td>
</tr>
<tr>
<td>PRDefaults</td>
<td>Responsibility</td>
<td>varchar(20)</td>
<td>varchar(10)</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>OurRole</td>
<td>varchar(20)</td>
<td>varchar(15)</td>
</tr>
<tr>
<td>PRTemplate</td>
<td>Responsibility</td>
<td>varchar(20)</td>
<td>varchar(10)</td>
</tr>
<tr>
<td>SENavTree</td>
<td>TriggerModule</td>
<td>varchar(255)</td>
<td>varchar(20)</td>
</tr>
<tr>
<td>SEUser</td>
<td>ODBCEnabled</td>
<td>varchar(1) NOT NULL default (‘N’)</td>
<td>varchar(1) NOT NULL default (‘Y’)</td>
</tr>
</tbody>
</table>
## New Objects

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Object Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLTK$AddBusinessDays</td>
<td>Function</td>
</tr>
<tr>
<td>DLTK$tabRound</td>
<td>Function</td>
</tr>
<tr>
<td>fnSplitOrg</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabCalendarMultiScales</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabCalendarStartEndDate</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabOrgLevel</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabPeriodETCReporting</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabProjectView</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabProjectViewPeriod</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabProjectViewPeriodReporting</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabProjectViewReporting</td>
<td>Function</td>
</tr>
<tr>
<td>ngRP$tabResourcesReporting</td>
<td>Function</td>
</tr>
<tr>
<td>ngRPGetConCatTaskName</td>
<td>Function</td>
</tr>
<tr>
<td>ngRPGetConCatTaskWBS1</td>
<td>Function</td>
</tr>
<tr>
<td>RP$tabAddJTDResource</td>
<td>Function</td>
</tr>
<tr>
<td>ngRPChangeDuration</td>
<td>Stored Proc</td>
</tr>
<tr>
<td>ngRPReCalcPlan</td>
<td>Stored Proc</td>
</tr>
<tr>
<td>ngRPShiftAssigment</td>
<td>Stored Proc</td>
</tr>
<tr>
<td>ngRPShiftDates</td>
<td>Stored Proc</td>
</tr>
<tr>
<td>ngRPShiftTasks</td>
<td>Stored Proc</td>
</tr>
<tr>
<td>ngRPUpdateTPD</td>
<td>Stored Proc</td>
</tr>
<tr>
<td>DeleteCFGEKStatusTrigger</td>
<td>Trigger</td>
</tr>
<tr>
<td>DelFW_CFGAttachmentCategory</td>
<td>Trigger</td>
</tr>
<tr>
<td>InsertCFGEKStatusTrigger</td>
<td>Trigger</td>
</tr>
</tbody>
</table>
### Database Changes

#### Object Name | Object Type
---|---
InsFW_CFGAttachmentCategory | Trigger
UpdateCFGEKStatusTrigger | Trigger
UpdateGovWinLabel | Trigger
UpdFW_CFGAttachmentCategory | Trigger
VisionAudit_Delete_FW_Attachments | Trigger
VisionAudit_Delete_OpportunityCompetitionAssoc | Trigger
VisionAudit_Insert_FW_Attachments | Trigger
VisionAudit_Insert_OpportunityCompetitionAssoc | Trigger
VisionAudit_Update_FW_Attachments | Trigger
VisionAudit_Update_FW_Files | Trigger
VisionAudit_Update_OpportunityCompetitionAssoc | Trigger
CFGEKStatus | View
FW_CFGAttachmentCategory | View

### Removed Objects

#### Object Name | Object Type
---|---
DeleteCFGOurRoleTrigger | Trigger
InsertCFGOurRoleTrigger | Trigger
UpdateCFGOurRoleTrigger | Trigger
VisionAudit_Delete_EMInitiation | Trigger
VisionAudit_Insert_EMInitiation | Trigger
VisionAudit_Update_EMInitiation | Trigger
CFGOurRole | View
Appendix A: Software Issues Resolved and Enhancements in Vision 7.5 Cumulative Updates

The following resolved software issues and enhancements in the Vision 7.5 cumulative updates (issued after the 7.5 release) are also included in the Vision 7.6 release.
Cumulative Update 07: Released May 26, 2016

Software Enhancements

Custom Timesheet Validation

This enhancement applies if you use Vision installed in the cloud (Deltek First Vision Essentials).

If you use VisionXtend, you can now create a stored procedure for timesheet validation. You must name the stored procedure `Custom_TimeSheetValidation`.

On the Web Services form in Vision Configuration » Workflow » Web Services, when you enter a row in the grid for the custom timesheet validation, you must enter the following in the Web Service Method field: `DeltekVisionOpenAPIWebService.Custom_TimesheetValidation`.

For more information and an example of a stored procedure for timesheet validation, see the "Extending Data Validation Business Logic for Timesheets" section of the Deltek VisionXtend 7.5 Web Services and APIs for Deltek Vision guide.

Files Updated

Deltek.Vision.TimekeeperBO.Server.dll
Deltek.Vision.WebServiceAPI.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Software Issues Resolved

Planning

Defect 591369: When the period occurred before the row's start date and there were hours were entered into a cell that did not have any prior hours entered, there was a delay in refreshing the planned billing amount.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated


Other Applications Affected

Database Changes

System File Dependencies
Planning » Project Planning

Defect 608002: When there were multiple effective rates in a rate table, Planning did not return rates for any period that occurred after the last escalation.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
Cumulative Update 06: Released May 13, 2016

Software Enhancements

Interactive Billing: Transfer Monetary Amounts for Expenses Without Transferring Quantity (Units)

In Billing » Interactive Billing, you now have the ability to transfer monetary amounts for expenses without transferring quantity (units). This applies if an expense item is a reimbursable or consultant expense that was generated from a voucher that you created using the Create Voucher from PO application.

To transfer expense amounts only:

1. In Interactive Billing, open the project for the expense that you want to transfer (source project).
2. On the Expenses tab of the Interactive Billing form, select the expense to transfer, and click the Transfer option on the grid toolbar.
3. In the Billing Expense Transfer dialog box:
   a. In the Project field, enter the project to receive the expense amount (target project).
   b. Delete the number in the Quantity field, leaving the field blank.
      This enables the Amount field, which is normally read-only.
4. In the Amount field, enter the amount to transfer.

When you click OK in the Billing Expense Transfer dialog box:

- For the source project, the expense amount and unit price is reduced. The quantity (units) remains the same as before the transfer. It does not get zeroed out.
- The target project has a new expense with the transferred monetary cost amount and a quantity and unit price of zero.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
IQ Web Service Utility: New Check Boxes

The following two check boxes were added to the Configuration tab in Utilities » Advanced Utilities » GovWin IQ Web Service to facilitate data imports:

- **Ignore Required Fields when Creating New Records**: Select this check box to allow the system to ignore all fields that are required as configured in Screen Designer when you perform the data import. This includes Opportunities, Clients, and Contacts. System-required fields are still required by the data import.

- **Allow Import to Trigger Workflows**: Select this check box to start the user-defined workflows for the newly imported data.

**Files Updated**
Deltek.Vision.IQWebService.Server.dll
Deltek.Vision.IQWebService.client.dll
Deltek.Vision.ContactInfoCenter.Server.dll
DeltekVision75GACU06.sql

**Other Applications Affected**

**Database Changes**
Added columns IQIgnoreRequiredFields and IQAllowWorkflows to CFGVisionSystem.

**System File Dependencies**

---

**Software Issues Resolved**

**Accounting » Adjust Salaried Job Cost**

**Defect 594490**: This issue applies if you use the Multicompany feature and you associated an employee record with one or more companies. When you ran Adjust Salaried Job Cost in a company that was not an employee’s home company, Vision incorrectly used the job cost rate from the employee’s home company. It should have used the job cost rate from the active company from which you ran Adjust Salaried Job Cost.

**Customers Impacted**: This defect applies to Vision 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**
Other Applications Affected

Database Changes

System File Dependencies

**Accounting » Project Review**

**Defect 595243:** If the **Basis for Planning Calculations** field was set to **Period End Date** in the Options dialog box of Project Review, the value of the **Estimate at Complete** field on the Cost tab on the Project Review form included the next period's amounts, which was incorrect.

**Customers Impacted:** This defect applies to Vision 7.3–7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

DeltekVision75GACU06.sql

**Other Applications Affected**

Database Changes

Updated PR$tabETC function.

System File Dependencies

**Info Center » Opportunities**

**Defect 600831:** You received the following error when you tried to save a new opportunity: "The given key was not present in the dictionary." This occurred if you did not have any custom fields for the Opportunities Info Center.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** Add a custom field to the Opportunities Info Center.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**

Database Changes
System File Dependencies

Planning

Defect: 594744 When a project that corresponded to a plan had many tasks, the SQL that was used to create JTD resource data caused slow performance when the plan was loaded.

Customers Impacted: This defect applies to Vision 7.5 CU 04 and CU 05.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
DeltekVision75GACU06.sql

Other Applications Affected

Database Changes

Updated the RP$tabAddJTDResource function.

System File Dependencies

Defect 582910: The Cost Analysis tab incorrectly displayed in Project Planning when a user’s role security was set up to hide the tab. (You hide the tab from view for a role on the Access Rights tab in Configuration » Security » Roles.)

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 604740: You received the following error when you tried to open a project plan: "Index was out of range. Must be non-negative and less than the size of the collection. Parameter name: index." This error can be caused by the accordion calendar being outside the date range of the plan. To prevent this situation, an Overflow column has been added to the beginning of the calendar grid on each of the Labor, Expense, Consultant, and Unit tabs. It is similar to the Overflow column at the end of the calendar grid. If the accordion calendar is outside the date range of the plan, these Overflow columns will hold the amounts that apply to dates outside the data range of the plan. This prevents the error message.
Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: none.

Additional Notes: None.

Files Updated
DeltekVision75GACU06.sql

Other Applications Affected

Database Changes
The pmGetPlan stored procedure was updated.

System File Dependencies

Proposals

Defect 586789: For custom proposals that included merged employee resume categories, extra returns were incorrectly inserted after a resume paragraph with non-bulleted text if the paragraph was followed by a paragraph with bulleted text.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: none.

Additional Notes: None.

Files Updated
Deltek.Vision.MergeBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Reporting

Defect 555417: When you used the Download option for any report and then tried to save the report as a Microsoft Excel file, it saved the file using the .xls file type instead of the correct .xlsx file type for Excel. This also occurred when you tried to download a report by previewing it first and then clicking the Download Report icon within the previewed report.

Customers Impacted: This defect applies to Vision 7.4 and 7.5 when you use any version of Microsoft SQL Server 2012 or 2014.

Workaround Before Fix: None.

Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

**Reporting » Accounts Receivable**

**Defect 593279:** You received the following error when you ran the AR Statement report if you had selected the **Only Include Past Due Invoices** check box on the Options tab of the AR Statement Options dialog box: “An error occurred during the processing (rsProcessingAborted). Query execution failed for dataset 'ReportDataset'. (rsErrorExecutingCommand). For more information about this error navigate to the report server on the local server machine, or enable remote errors.”

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** Clear the **Only Include Past Due Invoices** check box before running the report.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

Database Changes

System File Dependencies

**Defect 593292:** When you ran the AR Aged report, if you selected a large number of projects to include in the report, it took a long time for the report to process.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
AR Aging.rdl


**Other Applications Affected**
Database Changes

System File Dependencies

**Reporting » Equipment**

**Defect 601626**: The Asset Summary report did not show accumulated depreciation for assets that were imported, which it should have.

**Customers Impacted**: This defect applies to Vision 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

- Asset Summary.rdl

**Other Applications Affected**

Database Changes

System File Dependencies

**Reporting » Project**

**Defect 573051**: The Project Progress and Project Detail reports had a blank page at the end of the report.

**Customers Impacted**: This defect applies to Vision 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

- Project Progress.rdl

**Other Applications Affected**

Database Changes

System File Dependencies
Defect 574090: When you previewed the Project Progress report in Reporting » Project, if you had the Print Financial Analysis check box selected on the General tab of the Project Progress Options dialog box, a part of the financial analysis information spilled over the next page of the report.

Customers Impacted: This defect applies for Vision 7.5.

Workaround Before Fix: Before printing the report, adjust the page margins to try and fit the information on the first page.

Additional Notes: None.

Files Updated
Project Progress.rdl

Other Applications Affected

Database Changes

System File Dependencies

Time and Expense » Timesheet

Defect 595515: When employees entered a project in Time & Expense » Timesheet, the Labor Code field prefilled with zeros if there was no default labor code entered on the Time tab of Info Center » Employees. The Labor Code field should have been blank.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Transaction Center » Transaction Entry and Transaction Posting

Defect 592545: Company-paid expenses that were entered for an expense report posted to the incorrect credit account in the following situation:
• You entered multiple company-paid expense items on an expense report—some paid by credit card and some not paid by credit card.

• In the employee expenses entry grid, you entered the company-paid expense items that were paid by credit card before you entered the company-paid expense items that were not paid by credit card.

The company-paid expense items that were paid by credit card were incorrectly included in the credit amount for the company-paid expense items that were not paid by credit card. This resulted in a tolerance amount on the Tolerance report (in Advanced Utilities).

**Customers Impacted**: This defect applies to Vision 7.3–7.5.

**Workaround Before Fix**: On an expense report, enter company-paid expense report items paid via a credit card at the end of the expense report, after any company-paid expenses that are not paid by credit card.

**Additional Notes**: None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

---

**Utilities » Advanced Utilities » Data Import**

**Defect 599398**: When you used Advanced Import in the Data Import utility and you selected the CRMHours field on the Text File Fields Mapping tab for the Project-Employee table, you received the following Data Import error: "The definition for column ‘CRMHours’ must include a data type."

**Customers Impacted**: This defect applies to Vision 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Utilities » Advanced Utilities » GovWin IQ Web Service

Defect 605160: When you ran the GovWin IQ Web Service utility in Utilities » Advanced Utilities » GovWin IQ Web Service, duplicate opportunity records were created for opportunities with an inactive status.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.IQWebService.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Defect 605155: When you ran the GovWin IQ Web Service utility in Utilities » Advanced Utilities » GovWin IQ Web Service and you used auto-numbering for opportunities, opportunity IDs were not auto-generated as they should have been. The opportunity ID incorrectly displayed [Autonum] or it was blank.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.IQWebService.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Utilities » History Loading » Labor and Expense

Defect 589067: This applies if you use the Multicompany feature but not the Multicurrency feature in Vision. In Utilities » History Loading » Labor and Expense, you received the following error when you searched for a project in the Search field: "The multi-part identifier "EM.EmployeeCompany" could not be bound."

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.
Files Updated
Deltek.Vision.HistoryLoadingPR.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

**iAccess**

**Defect 604548**: Displaying or saving touchpoints and milestones in the Business Development workspace in iAccess took too long.

**Customers Impacted**: This defect applies to iAccess 2.1 and later versions when used with Vision 7.4 or 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

Files Updates

Other Applications Affected

Database Changes

System File Dependencies
Cumulative Update 05: Released April 15, 2016

Regulatory Enhancements

2016 Oregon SUTA Electronic Filing
Effective Q1 2016, the State Income Tax Withheld field (RS Record positions 287-297) is now required for Oregon. This field is right-justified and zero-filled, should not include commas or decimals, and does not allow negative amounts.

Files Updated
Deltek.Vision.QTRMagMedia.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Software Enhancements

Download Button on Workbooks Tab
The Workbooks tab now includes a Download button that allows you to open a File dialog box and specify the location for downloading and saving the published workbook (TWB) file.

This button is only enabled when the row that is selected in the grid contains either a sample published workbook or a workbook that was uploaded.

Files Updated
Deltek.Framework.PerformanceDashboard.server.dll

Other Applications Affected

Database Changes

System File Dependencies

Software Issues Resolved

Vision
Defect 595622: When an error was encountered, Vision displayed a CDATA error instead of the correct error for the issue.
**Customers Impacted:** This defect applies to Vision 7.5 Cumulative Update #4 and later versions.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Accounting » AP Invoice Approvals**

**Defect 584886:** When the **Maintain Separate Balance Sheets by Organization** check box (**Configuration » Organization » General Setup**) was not selected, a Balance Sheet account could not be entered with an AP Invoice Approval.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** Do not use AP Invoice Approvals for charges that are hitting balance sheet accounts.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.APInvoiceApprovals.Client.dll
Deltek.Vision.DataEntryGlobals.Client.dll
Deltek.Vision.APInvoiceApprovals.Server.dll

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Accounting » Budgeting » General Ledger**

**Defect 594710:** On the General Ledger Budget form, when you used **Tools » Copy Amounts** to copy amounts from an income statement or balance sheet, you were required to enter a profit center even if you did not have Profit Centers enabled in Vision.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.
Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

**Accounting » Credit Card » Credit Card Reconciliation**

Defect 591838: In Accounting » Credit Cards » Credit Card Reconciliation, when you selected a credit card statement on the Credit Card Statement Selection dialog box and clicked the Select button, the application would not open. You received a "Not Responding" message, and you had to close Vision. This occurred in some, but not all, Vision databases.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 592555: When you clicked Accounting » Credit Cards » Credit Card Reconciliation, it took a long time for the Credit Card Reconciliation application to open. This occurred in some, but not all, Vision databases.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: The Credit Card Reconciliation application will open if you wait (takes approximately 2 minutes or more). If you cannot install the April CU, which will fix this issue, another option is to contact Deltek Customer Care to obtain a script that will fix it.

Additional Notes: None.

Files Updated
DeltekVision75GACU05.sql

Other Applications Affected

Database Changes
Added Index LedgerEXCreditCardPKeylDX

**System File Dependencies**

**Accounting » Gains_Losses and Revaluations**

**Defect 595249:** This defect applies if you use multiple currencies in Vision and do not have multiple companies in Vision. When you ran Gains/Losses and Revaluations, you received a "FrameworkException: Incorrect syntax near '*'" error.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Billing**

**Defect 586531:** When you clicked Interactive Billing, Invoice Approvals, or Interactive Approvals in the Billing menu, the applications opened after a delay.

**Customers Impacted:** This applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

DeltekVision75GACU05.sql

**Other Applications Affected**

**Database Changes**

Updated CreateApproverTable stored procedure

**System File Dependencies**
**Configuration » Workflow » Performance Management**

**Defect 585148:** When you used the *Upload* button in **Configuration » General » Performance Management** to import a custom workbook, the workbook format was not always consistent if either of the following applied:

- The custom workbook had a data source that was different from your production system (for example test, dev, and so on).
- You use Deltek First Vision Essentials (Vision delivered via the cloud).

The Deltek VPM framework was modified to resolve this issue.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Configuration » Workflow » Scheduled Workflows**

**Defect 588433:** When a Scheduled Workflow was run on the Employee Child table and the action included a column change on the EMAllCompany table, the main table field was not updated.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** Column changes for custom fields and child table column changes are working correctly. Also, similar User Initiated Workflow works correctly.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Connect for Microsoft Outlook

**Defect 587609:** The Connect for Microsoft Outlook download and installation (from Vision Utilities » Download Connect for Microsoft Outlook) failed if you have Outlook 2010 64bit installed.

**Customers Impacted:** This applies if you use Vision 7.4 or 7.5 and Connect for Microsoft Outlook.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

Human Resources » Payroll » Payroll Processing

**Defect 590493:** This applies if you have multiple companies in Vision. If timesheets were entered in different companies for an employee for the same payroll period and then all the timesheets were posted, when you processed payroll for the first company, the hours from the employee’s timesheets from all companies were included in the paycheck. This incorrect amount displayed on the paycheck stub. When you processed payroll for the remaining companies, no hours were processed or displayed on the paycheck stubs.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** For the first company, post timesheets, run payroll, and post payroll. Then do the same for the next company, and each remaining company.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.PayrollBO.Server.dll

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 591997:** When an employee was associated with more than one company, payroll was not processed correctly. Specifically, after payroll was posted in one company and then it was
processed in the other company, the paycheck stub displayed the rates, hours, and amounts paid from the previous paycheck on the current paycheck.

**Customers Impacted:** This defect applies to clients using Vision 7.5 and Multicompany.

**Workaround Before Fix:** Post a timesheet and then payroll for one company and then repeat the process for the other company.

**Additional Notes:** None.

**Files Updated**
- EarningsHourly_Three.rdl
- EarningsHourly_Two.rdl

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Info Center**

**Defect 589884:** When using Vision Multicompany and an Advanced saved search created in a prior version was modified, an 'Object reference not set to an instance of an object' error message displayed.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 593352:** On the Activities tab of the Opportunities Info Center, when you opened the Employee lookup in the Owners field in the Activities grid, you received an error.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.InfoCenters.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Info Center » Employees
Defect 582283: When you clicked the Documents tab in the Employee Info Center, you received the following error: "Invalid object name 'DocumentsEMAllCompany'."
Customers Impacted: This defect applies to Vision 7.5.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Info Center » Projects
Defect 591986: Users who had a security role with full access to all projects and record-level update rights to only some projects, were incorrectly allowed to update information on the Contract Management tab in the Project Info Center for all project. (On the Record Access tab in Configuration » Security » Roles, full access to all projects is specified in the Access column of the Application Record Access grid. The ability to update only specific projects is specified in the Record Level Update column in the Application Record Access grid.)
Customers Impacted: This defect applies to Vision 7.3–7.5.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated
Deltek.Vision.ProjectInfoCenter.Client.dll

Other Applications Affected

Database Changes
System File Dependencies

**Info Center » Vendors**

**Defect 591365:** This applies if you use the Dutch language for Vision. In the Vendor Info Center, when you clicked the **Validate Tax Registration** button on the General tab and the tax ID was valid, the dialog box displayed a message in Dutch that said “Het BTW-nummer is ongeldig” (“The VAT number is invalid”). The message should have said “Het BTW-nummer is geldig” (The VAT number is valid).

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5 if you use the Dutch language.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

Deltek.Vision.InfoCenters.Client.dll

**Other Applications Affected**
Database Changes

System File Dependencies

Planning

Defect 594173: Task rows in Project Planning incorrectly displayed in red (indicating unmatched actuals) when an employee was assigned to a labor code level but Vision did not recognize the assignment.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Utilities » Advanced Utilities » INPUT Web Service

Defect 591948: Running an IQ import for inserts failed and displayed the following error: "invalid row at position 0". This occurred if the IQ update process resulted in any inserts. Updates worked as expected.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
Utilities » Key Formats » Employees

Defect 591426: If you set up employee IDs to not display leading zeros (in the Key Formats utility for employees, you cleared the Display Leading Zeros check box), Employee lookups would not retrieve employees with a space in the employee ID as they should have.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.EmployeeInfoCenter.Client.dll

Other Applications Affected

Utilities » Report Administration

Defect 590957: In the Report Administration utility, it took a long time to load a custom report when you clicked Load Report Files on the Load Reports tab if you had selected the Delete Existing Reports in Each Folder Before Loading check box on the tab.

Customers Impacted: This defect applies to Vision 7.4 and later versions.


Additional Notes: None.

Files Updated

Other Applications Affected

Vision Xtend

Defect 591864: This applies if you use VisionXtend. When the DupeCheckFields options for SendDataToDeltekVisionWithReturn were used, PR, PRCClientAssoc tables were not being converted to updates when their parent records were converted. Child tables should have been converted with their parents.
Customers Impacted: This defect applies to VisionXtend and Vision 7.3 - 7.5.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated
Deltek.Vision.WebServiceAPI.Server.dll
Other Applications Affected

Database Changes

System File Dependencies

Defect 593856: If you use VisionXtend, when you ran an API request, you inconsistently received the following error: "Could not load file or assembly 'Oracle.DataAccess."
Customers Impacted: This defect applies if you use VisionXtend and have Vision 7.5 CU 04 installed.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated
Other Applications Affected

Database Changes

System File Dependencies
Cumulative Update 04: Released March 18, 2016

Software Enhancements

Analysis Cubes

If you configured Vision Analysis Cubes to be scalable, you are no longer required to have the same Microsoft SQL Server editions on the Vision transaction database, data warehouse, and Analysis Services servers. However, if you have the SQL Server Enterprise edition on your Vision transaction database server and you deploy the Standard edition on the data warehouse and/or Analysis Services server, you will not have access to the functionality that is limited by Standard edition. See the “Microsoft SQL Server Edition Dependencies” section in the Deltek Vision 7.5 Installation and Configuration Guide for Performance Management for more information.

Conversely, if your Vision transaction database server has the SQL Server Standard edition and you deploy the Enterprise edition on the data warehouse and/or Analysis Services servers, you will gain this functionality. The loss or gain of functionality is entirely dependent on the edition of SQL Server that is installed on the server running Analysis Services.

When you install this CU release, you will receive the following message:

“Setup has detected that the selected database has either the Performance Management or Analysis Cubes modules enabled. Please refer to the release notes for this Cumulative Update to determine if it is necessary for you to rebuild your cubes. Setup will continue.”

Unless you are building scalable cubes with different SQL Server editions, you do not need to rebuild your cubes or republish dashboards at this time.

Files Updated

DeltekVisionResourceKit.exe
DeltekVision75GACU04.sql

Other Applications Affected

Database Changes

Added code to update the sp_AddDefaultKPI.sql

System File Dependencies

Performance Management Dashboards

With the changes to the SQL Server edition support for scalable Analysis Cubes (described above), the SQL Server edition on your Analysis Services server will drive the edition dependencies for the Performance Management dashboards. If you have SQL Server Enterprise on your Analysis Services server, you will have access to the dashboards listed in the “Microsoft SQL Server Edition Dependencies” section of the Deltek Vision 7.5 Installation and Configuration Guide for Performance Management. Conversely, if you have SQL Server Standard on your
Analysis Services server, you will **not** have access to the dashboards listed in the “Microsoft SQL Server Edition Dependencies” section of the guide.

**Files Updated**

DeltekVisionResourceKit.exe  
DeltekVision75GACU04.sql  

**Other Applications Affected**

**Database Changes**

Added code to update the sp_AddDefaultKPI.sql

**System File Dependencies**

**General System Settings**

A new Azure Active Directory tab has been added to the General System Settings form in **Configuration » General » System Settings**. Use this tab to configure single sign-on that uses Microsoft Azure Active Directory (Azure AD). Single sign-on allows users to log into Vision using their Windows user name and password when your company’s Active Directory domain is hosted within the Microsoft Azure cloud.

This new single sign-on support does not affect or replace the Windows Authentication functionality that was previously available natively within Vision for on-premise customers. Instead, it expands functionality for Vision’s cloud offering, Deltek First Vision Essentials, and broadens single sign-on support for on-premise Vision.

For the complete steps to configure single sign-on functionality, see one of the following guides:

- *Deltek First Vision Essentials Administrator Guide (for customers who access Vision via the Deltek cloud)*
- *Deltek Vision Technical Installation Guide (for customers who have Vision deployed on-premise)*

**Files Updated**

Deltek.Framework.Frame.Client.dll  
Deltek.Framework.SysLogin.Server.dll  
Deltek.Framework.Controls.Client.dll  
Deltek.Vision.FrameUI.Client.dll  
Weblink.exe
DeltekVision75GACU04.sql

Other Applications Affected

Database Changes
Added the following fields to FW_CFGSystem:

- WAADTenant
- WAADClientID
- WAADServerClientID
- WAADServerClientSecret
- WAADAuthType

System File Dependencies

ODBC Connectivity for the Cloud Offering of Vision
A new Flex Cloud ODBC Connectivity module has been added to Configuration » Module Activation. From Deltek First Vision Essentials, the Vision cloud offering, you can activate this module, which allows you to have read-only ODBC connectivity between an ODBC compliant tool of your choice and the Vision Essentials transaction database. This connection allows you to extract and read data from the Vision database, for example for reporting purposes, or to pull Vision data into third-party software, and so on.

When you activate the Flex Cloud ODBC Connectivity module, a Cloud ODBC section displays on the General tab of the Users form in Configuration » Security » Users. Complete these fields to configure the ODBC connectivity for a user. Five users at a time can use ODBC connectivity. For more information about setting up and using ODBC connectivity, see the Deltek First Vision Essentials Administrator Guide.

Files Updated

Deltek.Vision.SecUsers.Client.dll
Deltek.Vision.SecUsers.Server.dll
Deltek.Vision.EmployeeInfoCenter.Server.dll
visionModules.xml

Database Change
Added code to update the SEUser.ODBCEnabled field to 'N' WHERE ODBCUsername IS NULL.
Providing Single Sign-On for Deltek First Vision Essentials with Microsoft Azure Active Directory

A Vision Essentials administrator can now enable single sign-on for Deltek First Vision Essentials using Microsoft Azure Active Directory (Azure AD). This allows Vision Essential users to log onto Vision Essentials using their Windows user name and password instead of a separate Vision Essentials user name and password. Azure AD allows you to securely synchronize your users’ network credential information to the cloud.

Before users can log onto Vision Essentials with their Windows user name and password, a Vision Essentials administrator must:

1. Sign up for a Microsoft Azure AD account.
2. Complete the single sign-on configuration in Azure AD.

If your firm does not already have a Microsoft Azure AD account, you can sign up for a free account at https://azure.microsoft.com/en-us/free.


For the steps on how to configure single sign-on in Microsoft Azure AD and complete the configuration in Vision Essentials, see the Deltek First Vision Essentials Administrator Guide.

Files Updated
Deltek.Framework.Frame.Client.dll
Deltek.Framework.SysLogin.Server.dll
Deltek.Framework.Controls.Client.dll
Deltek.Vision.FrameUI.Client.dll
Weblink.exe
DeltekVision75GACU04.sql

Other Applications Affected

Database Changes
Added the following fields to FW_CFGSystem:
- WAADTenant
- WAADClientID
• WAADServerClientID
• WAADServerClientSecret
• WAADAuthType

System File Dependencies

Software Issues Resolved

Accounting » AP Invoice Approval

Defect 577913: In Accounting » AP Invoice Approvals, you were required to enter project data when there was an employee entered in the Route to field. Project data should not have been required.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: When a route-to employee is entered and some project charge data has been entered for step 0, but you do not know the project, you can enter a dummy project that is set up for this purpose.

Additional Notes: None.

Files Updated
Deltek.Vision.APInvoiceApprovals.Client.dll
Deltek.Vision.DataEntryGlobals.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Billing

Defect 564080: When the Separate Terms option was not selected for Billing Groups, Enable Posting by Billing Phase was selected and posting was split between two projects, and Billed Revenue allocation was based on transactions, the Fee Allocation amount for each project was incorrect.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: Post all to the main project or use Separate Terms in Billing group or do not enable posting by billing phase.

Additional Notes: None.

Files Updated

Other Applications Affected
Database Changes

System File Dependencies

**Billing » Interactive Billing**

Defect 566447: In Interactive Billing, when you downloaded invoices to RTF for editing (by clicking Invoice » Edit on the Interactive Billing form toolbar), the details incorrectly download in a table format.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
- Deltek.Framework.ExternalReferences.Server.dll
- SolidFramework.dll
- All files under SolidDocuments folder

**Other Applications Affected**

Database Changes

System File Dependencies

**Configuration » General » User Defined Tabs**

Defect 580589: The Configuration » General » User Defined Components application took a long time to load when the database had a large number of user-defined fields.

Customers Impacted: This defect applies to Vision 7.4.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

**Other Applications Affected**

Database Changes

System File Dependencies
**Configuration » Workflow**

**Defect 577896:** This defect applies if you use an approval workflow (created in Configuration » Workflow » Approval Workflows) for approving purchase orders, purchase requisitions, requests for price quotes, or item requests. In Purchasing, if a purchase order, purchase requisition, or request for price quote was rejected and then a change was made to it on the Default Distribution tab or Cost Distribution tab of the Purchasing form, the status of the purchasing item remained as **Rejected** instead of changing to **In Progress**. The **Submit** option was not available on the form toolbar as it should have been. This issue also applies for item requests in **Inventory**.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** On the Line Items tab for a purchase order or the General tab for a purchase requisition, request for price quote, or inventory item, change the item quantity and then change it back and save the record.

**Additional Notes:** None.

**Files Updated**

- Deltek.Vision.PurchaseOrder.Client.dll

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 578107:** When using Vision Multicompany, a scheduled workflow would fire too many emails if an Employee child table was specified as the workflow table.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**

**Database Changes**

**System File Dependencies**
**Connect for Microsoft Outlook**

**Defect 570114:** When you synchronized Connect for Microsoft Outlook and new Vision vendors had been entered in Microsoft Outlook, you received the following error message: "Parent object was not added." This could also occur if Vision contacts with associated activities had been added in Outlook.

**Customers Impacted:** This defect applies to Connect for Microsoft Outlook and Vision 7.4 or 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
- Deltek.Vision.WebServiceAPI.Server.dll

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 570139:** When Connect for Microsoft Outlook was synchronized after new Vision vendors were entered in Microsoft Outlook, you received the following error message: "Error performing operation: (InsertError) Column:Hubzone does not exist."

**Customers Impacted:** This defect applies to Connect for Microsoft Outlook and Vision 7.4 or 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Dashboard**

**Defect 575557:** When selecting the Subject in an Activity Dashpart on the Vision Dashboard, the following error displayed: Application Error: Ambiguous column name 'Location'.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.
Files Updated
Deltek.Vision.InfoCenters.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Info Center » Equipment

Defect 581053: The fields on the Additional Books tab in the Equipment Info Center were not prefilling from entries made on AP Vouchers in a single company environment when the **Maintain separate balance sheet** checkbox was selected in Organization setup.

Customers Impacted: This defect applies to Vision 7.5. single company Asset Management users with the **Maintain separate balance sheet** and **Create asset items from AP Vouchers** checkboxes selected.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Installation

Defect 581015: The Cumulative Update installer was updated to support the new shared databases.enc path (via the DatabasesEncDirectory appsetting in Webconfig) that will be used by Vision Configuration.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes
System File Dependencies

Planning

Defect 579103: There was slow performance when retrieving a plan. This was caused by issues with determining how unplanned resources were charged to the plan or project.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
DeltekVision75GACU04.sql

Other Applications Affected

Database Changes
Added function fn_RP$tabAddJTDResource.sql

System File Dependencies

Defect 584295: The Actual Overhead Amount that displayed on the Cost Analysis Tab of Project Planning did not match the value that was displayed in Project Review.

Customers Impacted: This defect applies to Vision 7.3 and later versions.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Reporting

Defect 573010: The Accounts Payable Data Export report displayed an incorrect Voucher Amount when there was tax on the expense amount and the transaction and functional currencies were different. Data export applied the tax amount from the transaction currency instead of the functional currency.
Customers Impacted: This defect applies to Vision 7.5.
Workaround Before Fix: None.
Additional Notes: None.

Files Updated
AccountsPayableDataSource.rdl

Other Applications Affected

Database Changes

System File Dependencies

Time and Expense » Expense Report

Defect 569324: When the expense category is changed in the Expense Report, both amount and mileage were recalculated. Only the amount should be recalculated. This issue happens if the expense category does not have the Automatically calculate miles when entering amounts check box selected.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.
Workaround Before Fix: Change the amount manually.
Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Time and Expense » Timesheet

Defect 581965: There was a performance issue when entering hours data in the Timesheet Hours tab of the Timesheet form. This happened if the Enable unit quantity feature option in the Setup tab in Company Timesheet Configuration form was selected and if there was a large number of records to be saved.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.
Workaround Before Fix: None.
Additional Notes: None.

Files Updated
Other Applications Affected

Database Changes

System File Dependencies

Transaction Center » Transaction Entry and Transaction Posting

Defect 582298: When using Vision Multicompany, if the tax currency of a tax code that was used in an AP Voucher was the same as the transaction currency of the voucher, but different from the company’s functional currency, the net amount on the Tax Analysis report when run in the tax currency would incorrectly display the net amount in the company’s functional currency instead of the tax currency.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Vision Xtend

Defect 576990: If the DupeCheckFields attribute is set in the InfoCenterXML when saving via SendDataToDeltekVisionWithReturn and the payload contains inserts that get converted to updates for the main table of an Info Center AND there is no corresponding custom tab field table record provided then the API will clear out all of the custom tab field columns for any record that was converted from an insert to an update.

Customers Impacted: This defect applies if you use VisionXtend and Vision 7.3 - 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.WebServiceAPI.Server.dll

Other Applications Affected

Database Changes
System File Dependencies

**Defect 583989**: This issue applies if you use VisionXtend. All custom tab field columns for any record that was converted from an insert to an update was cleared out in Vision if all of the following occurred:

- The DupeCheckFields attribute was set in the InfoCenterXML when saving via SendDataToDeltekVisionWithReturn.
- The payload contained inserts that got converted to updates for the main table of an Info Center.
- There was no corresponding custom tab field table record provided.

**Customers Impacted**: This defect applies if you use VisionXtend and Vision 7.3-7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

Deltek.Vision.WebServiceAPI.Server.dll
web/xsd/VisionGen.xsl

**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Cumulative Update 03: Released February 19, 2016

Software Issues Resolved

**Accounting » Accounts Payable » Payment Processing**

Defect 566588: On the Accounts Payable Payment Processing posting log, the amount in the *Payment Amount* column was different than the amount in the *Amount* column. The amounts should have been the same. The *Amount* column was missing the tax amount.

**Customers Impacted:** This defect applies to Vision 6.2 and later releases through 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

PostLogPP.rdl

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

---

**Accounting » Approvals Review**

Defect 561130: This applies if you have multiple companies in Vision. In Approvals Review, you were allowed to take action (approve) an absence request if the absence request belonged to a company that was not in the active company that you had logged into. You should have been allowed to take action only on an absence request that belonged to the active company.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Accounting » Gains/Losses and Revaluations

**Defect 559103:** This issue applies for gains/losses calculated for Accounts Payable payments that are made by direct debit when the payment currency is different than the functional currency and the bank’s currency. An incorrect gains/losses amount could be posted to the organization of the project for the original voucher. The gains/losses amount for the organization of the bank was correct.

**Customers Impacted:** This defect applies if you use multiple currencies in Vision 7.2 - 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

Database Changes

System File Dependencies

---

Accounting » Intercompany Billing

**Defect 533200:** This applies if you use multiple companies and the Credit Card feature in Vision. Amounts for intercompany billing invoices could be incorrect in some cases if expense items were entered as follows: In **Time & Expense » Expense Report**, you added an expense by selecting a credit card purchase from the Credit Card pane. The credit card for the expense was not the same as the credit card assigned to the active company that you selected when you logged into Vision.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

Database Changes

System File Dependencies

---

**Defect 572399:** When using an intercompany labor or expense transaction with **Tax** enabled, the Intercompany Billing invoice did not display a **Tax** section.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.
Additional Notes: None.
Files Updated
ICTaxes.rdl

Other Applications Affected

Database Changes

System File Dependencies

Billing » Interactive Billing

Defect 568877: Interactive Billing Transfers did not apply the new PKey value from the LedgerMisc Table, which resulted in a disconnect between the LedgerMisc Table and the LD Table.

Customers Impacted: This defect applies to Vision 7.4 and later versions.

Workaround Before Fix: None.

Additional Notes: This defect impacted clients using Adjust Salary Job Cost or those who wanted to use a workaround for Prevailing Wages.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 572368: This issues applies if you use TrafficLIVE and Vision and you linked timesheets between TrafficLIVE and Vision. You received the following error when you transferred labor records for linked timesheets in Vision Interactive Billing: "Charge Band does not match the Charge Band on budgeted TrafficLIVE Task." You should have been allowed to create a billing transfer with charge bands that did not match the budgeted TrafficLIVE task. The software has been changed so you will receive a warning message instead of an error message in this scenario.

Customers Impacted: This defect applies if you use TrafficLIVE and Vision 7.4 or 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected
Database Changes

System File Dependencies

Defect 573762: After you installed the January 2016 CU release, you received the following error when you transferred labor records in Interactive Billing: "SaveBO: Column 'TLChargeBandExternalCode' does not exist in table BILD."

IMPORTANT: In the February CU release, no software change was made to correct this issue. To prevent this error from occurring, before you install the February CU, clear the cache on users' workstations.

Customers Impacted: This applies if you use Vision 7.4 or 7.5.

Workaround Before Fix: Before you install the January CU release, clear the cache on users' workstations.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 573811: When you transferred labor in Interactive Billing, you received the following error message: "Cannot insert the value NULL into column 'EmployeeCompany', table." This occurred when you transferred labor from or to a project that was set up in Time Analysis, the project had an accrual code, and the source or target project did not have the same accrual code.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated


Other Applications Affected

Database Changes

System File Dependencies
Calendar/Activities » Activity Manager

Defect 428875: When a Global Saved Search was created and saved in the Activity Manager, it was later erased when another saved search was used or when you navigated away from the Activity Manager.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.InfoCenters.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Configuration » Workflow

Defect 573367: A scheduled workflow did not work if it had a condition with a SQL expression.

Customers Impacted: This defect applied to all scheduled workflows in Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 573809: When the Project Supervisor field was renamed on the system label, the renamed field displayed in the Employee lookup fields in the Workflow Email recipient instead of the Employee Supervisor. The renamed field also incorrectly displayed when the Employee lookup was used to populate the email. This resulted in the email not sending correctly.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.
Files Updated

Other Applications Affected

Database Changes

System File Dependencies

iAccess
Defect 579177: When you entered a valid labor code in a time record, iAccess displayed a “No results were found” message instead of accepting the entry.

Customers Impacted: This defect applies only to iAccess 2.2 for Vision. Though it involves a Vision database change, it does not affect Vision users.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
DeltekVision75GACU03.sql

Other Applications Affected

Database Changes
Updated the GetLaborCodeDesc function.

System File Dependencies

Info Center » Opportunities
Defect 576395: If you added an opportunity in Vision, specified a GovWin IQ ID as part of the record, and then ran the IQ Web Service utility to bring in additional information for the opportunity from GovWin IQ, the import process incorrectly replaced or blanked out some of the information that you entered originally for the opportunity.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.IQWebService.Server.dll

Other Applications Affected
Database Changes

System File Dependencies

Reporting

Defect 483384: When a scheduled recurring report is configured to always run in the current period and create an archive report, the scheduled recurring report does not include new current period data in the report when it generates.

For example:

1. Select the Project Audit report from Reporting > Project.
2. Select Email/Schedule drop-down from the reporting toolbar and select an option.
3. On the Email Report dialog box, configure the email recipient and click the Schedule button.
4. On the Schedule dialog box, configure the schedule when the report will be generated and click Options....
5. On the Options dialog box, select the Always run in the Current period and Create report archive options and click OK to save the settings and close the Options dialog box.
6. Click OK to save the settings and close the Schedule dialog box.

When the Project Audit report generates based on the schedule, the report does not include data from the new and current period.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: Run the report without scheduling it, or make sure that the Create report archive option on the Options dialog box is not selected when scheduling a report.

Additional Notes: None.

Files Updated

Deltek.Vision.dlgOpenNewPeriod.Client.dll

Other Applications Affected

Database Changes

System File Dependencies
**Reporting » Accounts Receivable**

**Defect 570073:** When you generated the AR Aged report in **Reporting » Accounts Receivable**, AR Comments are not included in the report even if you selected the **Print AR Comments** option in the Options tab of the AR Aged Options dialog box.

**Customers Impacted:** This defect applies to Vision 7.5 users.

**Workaround Before Fix:** Run the AR Comments report separately.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Defect 578516:** Generating an AR Aged report took longer than expected. This issue occurred if there were about 100 records to display.

**Customers Impacted:** This defect applies to Vision 7.5 users.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Time and Expense » Expense Report**

**Defect 569302:** Posting an expense report resulted in a syntax error if the value of the **Report Name** field included an apostrophe.

**Customers Impacted:** This defect applies to Vision 7.4.

**Workaround Before Fix:** Remove any apostrophes in the **Report Name** field.

**Additional Notes:** None

**Files Updated**

**Other Applications Affected**
Database Changes

System File Dependencies

Time and Expense » Timesheet

Defect 574549: A problem occurred if an employee belonged to multiple companies, posted a timesheet for one of those companies, then posted a timesheet for the second company for the same timesheet period. The second timesheet would appear to post, but would stay in Approved status. Its labor detail would not be posted.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision<Posting.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Transaction Center

Defect 559752: Journal Entry Reversals that were scheduled to post failed in the Process Queue when the database had International English (en-GB) enabled (not en-US).

Customers Impacted: This defect applies to Vision 7.4.

Workaround Before Fix: You can create the reversal manually.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
Utilities » Advanced Utilities » Search and Replace

Defect 568017: When you clicked Advanced Utilities » Search and Replace, then selected Billing Terms as the Application Area, the Column to Update field did not include some Billing Backup related fields. The missing fields were from the Billing Backup tab of the Billing Terms screen. They were the two Print Supporting Documents fields: A/P Vouchers and Expense Reports.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Utilities » Advanced Utilities » TrafficLIVE Web Service

Defect 567120: When you tried to open the TrafficLIVE Web Service application in Utilities » Advanced Utilities » TrafficLIVE Web Service, a blank screen displayed with a "Not Responding" status. It took a long time to successfully open the TrafficLIVE Web Service application. This occurred if you had run the TrafficLIVE web service many times and the TrafficLIVE Web Service Call Log grid on the General tab on the TrafficLIVE Web Service form displayed a large number of rows (for example, 150 rows) for the numerous web service runs.

Customers Impacted: This defect applies to Vision 7.4 and 7.5 if you use TrafficLIVE and the TrafficLIVE web service.

Workaround Before Fix: Clear all the logs

Additional Notes: None.

Files Updated
Deltek.Vision.TLWebService.Client.dll
Deltek.Vision.TLWebService.Server.dll

Other Applications Affected

Database Changes

System File Dependencies
Defect 567122: In Vision, timesheets that were received from TrafficLIVE using the TrafficLIVE web service had an incorrect date if the timesheet in TrafficLIVE had an end time before 12:00 PM. In Vision, the date that displayed in Transaction Center » Transaction Entry for the timesheet was the day before the timesheet's end time in TrafficLIVE.

Customers Impacted: This defect applies to Vision 7.4 and 7.5 if you use TrafficLIVE and the TrafficLIVE web service.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.TLWebService.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Defect 572365: This issue applies for billing labor transfers that involve timesheets that are linked between Vision and TrafficLIVE. In Vision Billing, if you entered a billing labor transfer and changed a charge band level 2 from billable to non-billable, this change was not reflected on the timesheet in TrafficLIVE after you ran the TrafficLIVE web service.

Customers Impacted: This defect applies if you use TrafficLIVE and Vision 7.4 or 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.TLWebService.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Defect 572381: When you created a job (project) in TrafficLIVE and then ran the TrafficLIVE web service, the job was not updated in Vision if you had not entered any default settings in Vision Configuration » General » Project Defaults. You received an error message: "There is no row at position 0."

Customers Impacted: This defect applies if you use TrafficLIVE and Vision 7.4 or 7.5.

Workaround Before Fix: Supply any fields on the Project/Job defaults.

Additional Notes: None.

Files Updated
Deltek.Vision.TLWebService.Server.dll
Other Applications Affected

Database Changes

System File Dependencies

**Defect 573003:** This issue applies for billing labor transfers and timesheets that are linked between Vision and TrafficLive. When you ran the TrafficLIVE web service, you received the following error if there were multiple billing labor transfers for the same timesheet: "HTTP Status 500 - Throwable occured in Service Layer."

**Customers Impacted:** This defect applies if you use TrafficLIVE and Vision 7.4 or 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.TLWebService.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

**Defect 574620:** This issue applies for jobs (projects) that are linked between Vision and TrafficLIVE. You received an "Object Reference not set to an instance of an object" error when ran the TrafficLIVE web service in the following situation:

1. You performed a key convert for job (project) numbers in **Utilities » Key Formats » Projects**.
2. On the General tab in **Utilities » Advanced TrafficLIVE Web Service**, you selected the **Sync from Vision to TrafficLIVE** check box and entered a row for the **Job Number** in the Fields to Sync grid.
3. You ran the TrafficLIVE web utility.

**Customers Impacted:** This defect applies if you use TrafficLIVE and Vision 7.4 or 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.TLWebService.Server.dll

Other Applications Affected

Database Changes
System File Dependencies

**Defect 575305:** This applies for billing labor transfers for timesheets that are linked between Vision and TrafficLIVE. You received the following error when you ran the TrafficLIVE web service: "HTTP Status 500 - JobTaskTimeEntryEntity with id xxxxx was updated by another user." You received this if the following occurred:

1. You entered two separate billing labor transfer in Vision Billing to split a timesheet that was originally entered in TrafficLIVE.
2. You did **not** run the TrafficLIVE web service after the first split.

**Customers Impacted:** This applies if you use TrafficLIVE and Vision 7.4 or 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.TLWebService.Server.dll

**Other Applications Affected**

Database Changes

System File Dependencies

**Defect 576921:** When you made changes to previously saved setting on the TrafficLIVE Web Service form and clicked **Run**, you received the following message: "Changes must be saved before scheduling the TrafficLIVE Web Service. Do you want to save your changes?" You should not have been required to save the changes before running the TrafficLive web service.

**Customers Impacted:** This defect applies if you use TrafficLIVE and Vision 7.4 or 7.5.

**Workaround Before Fix:** After you save changes and run the TrafficLIVE web service, reverse any changes on the TrafficLIVE Web Service form that you did not want to save.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.TLWebService.Client.dll

**Other Applications Affected**

Database Changes

System File Dependencies
Cumulative Update 02: Released January 22, 2016

Regulatory Enhancements

2016 District of Columbia Income Tax Withholding
The annual withholding table for all filing statuses is updated.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 Illinois Income Tax Withholding
The annual allowance increases from $2,150 to $2,175.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 Maryland Income Tax Withholding
These are the updates for Maryland:
- The tax rate in Anne Arundel County decreases from 2.56% to 2.5%.
- The tax rate in Worcester County increases from 1.25% to 1.75%.
- The tax rate for nonresidents increases from 1.25% to 1.75%.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes
System File Dependencies

2016 Massachusetts Income Tax Withholding
These are the updates for Massachusetts:
- The withholding rate decreases from 5.15% to 5.1%.
- The head of household tax value amount decreases from $123.60 to $122.40.
- The blindness tax value amount decreases from $113.30 to $112.20.
- The supplemental tax rate decreases from 5.15% to 5.1%.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 Minnesota Income Tax Withholding
The following are the updates for Minnesota:
- The withholding allowance increases from $4,000 to $4,050.
- The withholding tables for Single and Married are updated.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 Missouri Income Tax Withholding
The Head of Household standard deduction increases from $9,250 to $9,300.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected
Database Changes

System File Dependencies

2016 New York State Income Tax Withholding

These are the updates for New York:

- The Single deduction allowance amount increases from $7,350 to $7,400.
- The Married deduction allowance amount increases from $7,850 to $7,900.
- The Married and Single annual tax rate schedule tables change.
- Adjustment for difference between federal and New York exemption allowances increases from $2,950 to $3,000.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 North Carolina State Standard Deductions

These are the updates for North Carolina effective January 1, 2016:

- The standard deduction amount for head of household filers increases from $12,000 to $12,400.
- The standard deduction amount for single and married filers, filing separately, increases from $7,500 to $7,750.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies
2016 North Carolina Income Tax Withholding
The following are the updates for North Carolina:

- The income tax withholding rate increases from 5.75% to **5.85%**.
- The annual reconciliation date changes from February 28 to **January 31** for tax years starting after December 31, 2014.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 Oklahoma Income Tax Withholding
The following are the updates for Oklahoma:

- The annual withholding tables for Single and Married are updated.
- The supplemental withholding rate decreases from 5.25% to **5%**.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 Rhode Island Income Tax Withholding
These are the updates for Rhode Island:

- The annual withholding table for all filing statuses is updated.
- The threshold for 0.00 allowance amount increases from $214,700 to **$215,800**.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes
System File Dependencies

2016 Vermont Income Tax Withholding
The following are the updates for Vermont:

- The amount of one withholding allowance increases from $4,000 to $4,050.
- The percentage method withholding tables are updated.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Software Enhancements

Talent Management Web Service Utility
A new field, TalentModDate, was added to Vision's EMMain table to record the date and time when changes were made to the fields that are mapped from Vision to Talent Management.

When you run the Talent Management web service, Vision compares the value of the TalentModDate field to the date and time when the service was last run. The TalentModDate field is updated when any mapped field to Talent Management is changed in Vision. Vision sends any changes to Talent Management when you run the web service.

Files Updated
Deltek.Vision.EmployeeInfoCenter.Server.dll
TalentMapping.xml
DeltekVision75GACU02.sql

Other Applications Affected

Database Changes
Updated the following stored procedures:

- KeyCvtOrgLabcd
- KeyCvtEmployee
- KeyCvt
System File Dependencies

TrafficLIVE Web Service Utility

Vision Project Default Values Used for Linked Projects/Jobs Between Vision and TrafficLIVE

When you send project/jobs from TrafficLIVE to Vision, some fields for the linked project/job in Vision now prefill with project default values that are defined in Vision Configuration.

The following table shows the project/job fields in the Vision Project Info Center that prefill with the project default values that are specified in Vision Configuration » General » Project Defaults for project/jobs linked between Vision and TrafficLIVE. In Vision, the fields for new tasks that are created for existing linked projects/jobs between Vision and TrafficLIVE prefill with the values entered at the project level for a project/job.

<table>
<thead>
<tr>
<th>Tab in the Vision Project Info Center</th>
<th>Field in the Vision Project Info Center that Prefills from Project Defaults Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Organization</td>
</tr>
<tr>
<td>General</td>
<td>Responsibility</td>
</tr>
<tr>
<td>General</td>
<td>Principal-in-Charge</td>
</tr>
<tr>
<td>General</td>
<td>Supervisor</td>
</tr>
<tr>
<td>General</td>
<td>Biller</td>
</tr>
<tr>
<td>Accounting</td>
<td>Cost and Pay Rates section field:</td>
</tr>
<tr>
<td></td>
<td>▪ Cost Method</td>
</tr>
<tr>
<td></td>
<td>▪ Cost Table</td>
</tr>
<tr>
<td></td>
<td>▪ Pay Method</td>
</tr>
<tr>
<td></td>
<td>▪ Pay Table</td>
</tr>
<tr>
<td>Accounting</td>
<td>Cross Charge section fields:</td>
</tr>
<tr>
<td></td>
<td>▪ Apply Rate Method at this Level</td>
</tr>
<tr>
<td></td>
<td>▪ Rate Method</td>
</tr>
<tr>
<td></td>
<td>▪ Multiplies</td>
</tr>
<tr>
<td>Accounting</td>
<td>Unit Table</td>
</tr>
<tr>
<td>Accounting</td>
<td>AP Bill by Default section fields:</td>
</tr>
<tr>
<td></td>
<td>▪ Consultants</td>
</tr>
<tr>
<td></td>
<td>▪ Other Expenses</td>
</tr>
<tr>
<td></td>
<td>▪ Override Table</td>
</tr>
</tbody>
</table>
Cumulative Update 02: Released January 22, 2016

Release Notes: Technical Considerations

### Tab in the Vision Project Info Center | Field in the Vision Project Info Center that Prefills from Project Defaults Configuration
---|---
Accounting | Purchasing Commitments section fields:
- Consultant Multiplier
- Reimbursable Multiplier
Accounting | Restrict Charge Company check box
Budget & Revenue | Budgeted OH Rate
Budget & Revenue | Revenue Method
Budget & Revenue | Multiplier Amount

### Files Updated


### Other Applications Affected

### Database Changes

### System File Dependencies

### Billing Labor Transfers for Timesheets that Are Linked Between Vision and TrafficLIVE

The TrafficLIVE Web Service utility now has the ability to update linked timesheets in TrafficLIVE with billing labor transfers that you make to the linked timesheets in Vision.

You enter billing labor transfers for linked timesheets in Vision in **Billing » Interactive Approvals** and **Billing » Interactive Billing**.

You can enter billing labor transfers in Vision to:
- Change all the hours on a timesheet to a new project/job and task (or stage and task).
- Move some of the hours on a timesheet to a different project/job and task.

The update for linked timesheets in TrafficLIVE will occur if you select the **Billing Labor Transfer** check box in the Send to TrafficLIVE section on the General tab in Vision **Utilities --> Advanced Utilities --> TrafficLIVE Web Service** before you run the TrafficLIVE web service.

For more information, see the following online help topics:
- Billing Labor Transfers for Timesheets that Are Linked Between Vision and TrafficLIVE
- Workflow for Creating and Linking Timesheets Between Vision and TrafficLIVE

### Files Updated

Deltek.Vision.TLWebService.Client.dll
Deltek.Vision.TLWebService.Server.dll

Other Applications Affected

Database Changes
Added column TLProcessed to the BILD and LD tables.

System File Dependencies

Changing a Project/Job or Employee Number in Vision
In Vision Utilities » Key Conversions, you can change the number for a project/job or employee record that is linked with TrafficLIVE. The linked project/job or employee in TrafficLIVE is now updated with the new number when you run the TrafficLIVE web service if you entered the following settings on the General tab of the TrafficLIVE Web Service utility:

- You selected the Sync from Vision to TrafficLIVE check box.
- In the Fields to Sync grid:
  - For projects/jobs, you added a row for the Projects/Jobs Info Center and the Project/Jobs Number field.
  - For employees, you added a row for the Employees Info Center and the Employee Number field.

Files Updated

Other Applications Affected

Database Changes
Updated the following stored procedures:
- KeyConvertWBS1
- KeyConvertEmployee
- KeyCvt.sql

System File Dependencies

Software Issues Resolved

Accounting » Project Review
Defect 564348: The Equipment tab did not appear in the Project Review form. This occurred when the Asset Management module was activated, but the Purchasing module was not.

On the Equipment tab, the Purchase Order Number field, the Purchase Order Amount field, and the Vendor field should not display.
Customers Impacted: This applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: When Asset Management module is activated and Purchasing is not, the Purchase Order Number field, the Purchase Order Amount field, and the Vendor field do not display in the Equipment Tab.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Defect 568981: When opening or drilling down to a document in Project Review, Vision retrieved all documents in the database instead of the documents that were related to the selected project. This resulted in a performance issue.

Customers Impacted: This defect applies to Vision versions 7.3–7.5.

Workaround Before Fix: Open the document in Utilities » Files Administration.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Accounting » Tax File Generation

Defect 564764: For the VAT Declaration XML file, the tax amount did not display on the Review tab of the Tax File Generation form if a voucher had multiple line items.

Customers Impacted: This defect applies for Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected
Database Changes

System File Dependencies

Defect 561265: The VAT Declaration XML file and its detailed backup report had incorrect (doubled) tax amounts.

This occurred under the following circumstances:

- The following settings were entered for a tax on the Tax Codes tab in Configuration » Accounting » Taxes:
  - The Transaction Entry check box was selected in the Inputs section.
  - The Reverse Charge Tax check box was selected in the Non-Recoverable Tax section.
- You posted an accounts payable voucher transaction file that included vouchers that:
  - Used the tax code.
  - Had multiple transaction detail lines.
  - Were created for more than one vendor.

Customers Impacted: This applies to Vision 7.4 and 7.5.

Workaround Before Fix: Manually edit the tax file.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Billing

Defect 560856: When you previewed an invoice in Interactive Billing, you received an "Attempted to divide by zero" error. This could occur in some instances for invoices with taxes and billing limits.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected
Database Changes

System File Dependencies

**Configuration › General › Alerts**

**Defect 556515:** In Configuration › General › Company Alerts, if you set the Labor Billing Transfer Audit alert to Active and set the frequency to Send Alert once per week, the alerts were not sent.

**Customers Impacted:** This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

---

**Connect for Microsoft Outlook**

**Defect 570109:** New activities that you created in Connect for Microsoft Outlook did not synchronize with Vision. The error message in the Connect for Microsoft Outlook synchronization control panel was “object reference error.”

**Customers Impacted:** This defect applies for Connect for Microsoft Outlook and Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
Deltek.Vision.WebServiceAPI.Server.dll

**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Defect 570137: The associations that you made between opportunities and employees in Connect for Microsoft Outlook were not updated to the opportunities and employees in Vision when you synchronized. The error message in the Connect for Microsoft Outlook synchronization control panel was “message not received.”

Customers Impacted: This applies for Connect for Microsoft Outlook and Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.WebServiceAPI.Server.dll
xml\ValidationInfo.xml

Other Applications Affected

Database Changes

System File Dependencies

Defect 566063: In Connect for Microsoft Outlook, you could delete clients if your security role had only add/modify rights or read-only rights. You should not have been allowed to delete.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.WebServiceAPI.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Defect 562057: When you used Connect for Microsoft Outlook, duplicate contact records were incorrectly allowed in the following circumstances:

1. You entered a contact in Microsoft Outlook using native Outlook, not the Deltek contact form in Outlook.
2. The same contact was added in Vision and associated with an opportunity.
3. During synchronization, the contact that was added in Vision was brought into Connect for Microsoft Outlook as an incomplete record associated with an opportunity.
4. When you changed the contact in Outlook to Shared with Deltek and ran Compare and Merge Duplicates, duplicate contacts should have been found, but they were not.
Customers Impacted: This defect applies if you use Connect for Microsoft Outlook and Vision 7.3, 7.4, or 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

CMO 1.3.3.32

Other Applications Affected

Database Changes

System File Dependencies

Human Resources » ABRA Interface

Defect 560582: Scheduled jobs to import data from an ABRA server showed as completed on Process Queue Manager form, but employee data in Vision was not updated.

Customers Impacted: This defect applies to Vision 7.4.


Additional Notes: None.

Files Updated


Other Applications Affected

Database Changes

System File Dependencies

Human Resources » ABRA Interface » Import from ABRA

Defect 560588: While importing data from Vision to ABRA, an error occurred if the value for the Org in the EMInitiation table was null.

Customers Impacted: This applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated


Other Applications Affected
**Database Changes**

**System File Dependencies**

**Info Center » Equipment**

**Defect 563443**: When you selected the advanced lookup in the Equipment Lookup dialog box, **Assigned** was missing from the drop-down list in the **Search Field** field. This applies for the Equipment lookup in the Equipment Info Center, in the Asset Management application, and in Equipment Reporting.

**Customers Impacted**: This defect applies to Vision 7.5 if you use Asset Management.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

- Lookup_Equipment.xml

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Info Center » Opportunities**

**Defect 550355**: The fields from the Competition tab in the Opportunity Info Center were not included when performing a PowerPoint merge.

**Customers Impacted**: This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

- deltek.vision.integrationMicrosoftOffice.Server.dll

**Other Applications Affected**

**Database Changes**

**System File Dependencies**
Info Center » Projects

Defect 566521: When using the New » Create Project from Plan option in the Project Info Center, if the plan included an Employee Resource on a lower WBS level, an error displayed. This was caused by an issue with the INSERT statement conflicting with the FOREIGN KEY constraint.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: Manually create a new project or apply a script to temporarily remove the foreign key.

Additional Notes: None.

Files Updated
Deltek.Vision.ProjectInfoCenter.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Installation

Defect 571056: This issue applies for new installations of Vision 7.5 (not upgrade installations) and only if your Vision servers have non-English (United States) regional settings. When you installed Vision 7.5, the default <globalization> setting in the Vision web.config file was removed in error.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: Manually enter the <globalization> tag in the web.config file.

To do this:

1. Open Windows Notepad using the Run as administrator option. (Right-click the Notepad program icon, and on the shortcut menu, click Run as administrator.)
2. In Notepad, click File » Open.
3. In the Open dialog box, navigate to the Vision installation folder, select the web.config file, and click Open. (The default location of the file is C:\Program Files\Deltek\Vision\Web.)
4. In the web.config file that displays in Notepad, locate the <system.web> section, and add the following:
   
   <globalization requestEncoding="utf-8" responseEncoding="utf-8" culture="en-US" uiCulture="en-US" />

Additional Notes: None.

Files Updated
Other Applications Affected

Database Changes

System File Dependencies

Log In/Off

Defect 567207: When using a SaaS-enabled database with login alerts, the alerts were not decrypted properly and would display with incorrect characters.

Customers Impacted: This defect applies to clients using Vision 7.4 with SaaS and login alerts.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Planning

Defect 564620: When using the Options » Plan Retrieval Mode dialog box with Retrieve Plan-Level JTD, ETC, Baseline, and Planned Data or Retrieve Only Planned Data selected, opening a plan resulted in an error message.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: Select the Retrieve All Data option on the Plan Retrieval Mode dialog box.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
Defect 561412: The Actual amount for the Direct Expense and Direct Consultant fields on the Cost Analysis tab of Project Planning were applying billing amounts instead of cost amounts.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
DeltekVision75GACU02.sql

Other Applications Affected

Database Changes
Updated the pmGetRPPlan stored procedure.

System File Dependencies

Proposals

Defect 570011: When you created a custom proposal, after you selected projects for specific employees and a format in the Resume by Query dialog box, you received the following error: "Length cannot be less than zero. Parameter name: length."

Customers Impacted: This defect applies to Vision 7.2–7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.allSF254255330Custom.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Proposals » SF330 Proposals

Defect 560584: In Proposals » SF330 Proposals, when you selected projects on the Section E tab, the city from the project did not display in the Title and Location field. Only the state displayed in this field.

Customers Impacted: This defect applies to clients using Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Reporting » Client**

**Defect 561298:** The Client Employee Assignment and Activity Status report displayed with no records (blank), even though report options were specified on the General tab and search criteria was entered on the Columns tab.

**Customers Impacted:** This defect applies to Vision 7.5 clients using the CRM application.

**Workaround Before Fix:** You must select the records in the search results before you select Apply. This will populate the report with the records.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Reporting » Data Export**

**Defect 553621:** In Reporting » Data Export Reporting, the **Award Type** field was not available on the Columns tab of the Opportunity Export Options dialog box for the Opportunity Export report.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**
OpportunityDataSource.rdl

**Other Applications Affected**
System File Dependencies

**Reporting » Project**

**Defect 562040**: In **Reporting » Project**, the contract number on the Contract Management report displayed even when **Contract Number** field was not selected on the Sorting and Grouping tab in the Contract Management Options dialog box.

**Customers Impacted**: This defect applies to clients using Vision 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**

Deltek.Vision.ReportingProject.Server.dll

**Other Applications Affected**

Database Changes

System File Dependencies

**Transaction Center**

**Defect 559449**: When you scheduled a journal entry via the process server to be reversed to a future date, the reversal updated the period it was created in and not the current open period.

**Customers Impacted**: This defect applies to Vision 7.4 and 7.5.

**Workaround Before Fix**: None.

**Additional Notes**: None.

**Files Updated**


**Other Applications Affected**

Database Changes

System File Dependencies

**Utilities » Files Administration**

**Defect 560186**: The **AP Invoice** option was missing from the **Application** drop-down field in **Utilities » Files Administration**.
Customers Impacted: This defect applies to clients using Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.Files.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

VisionXtend

Defect 552844: You received an error when you used an API web service for the Employee Info Center to update an employee association record.

Customers Impacted: This defect applies if you use VisionXtend in Vision 7.4 and 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.WebServiceAPI.Server.dll

Other Applications Affected

Database Changes

System File Dependencies
Cumulative Update 01: Released December 18, 2015

Regulatory Enhancements

2016 Federal Tax Withholding Tables
The following updates were made to the federal tax withholding tables:

- The amount of one withholding allowance increased from $4,000 to $4,050.
- The Married and Single percentage method withholding tables have been updated.
- The Nonresident Alien Adjustment amount decreased from $2,300 to $2,250.

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

2016 State Income Tax Withholding

California
The California state income tax changes are as follows:

- The annual standard deduction increased from $3,992 to $4,044.
- The low income exemption table has been updated for all filing statuses.
- The withholding tax rate table has been updated for all filing statuses.
- The annual exemption allowance for one increased from $118.80 to $119.90.

For more information, see:

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies
Connecticut

The Connecticut state income tax changes are as follows:

- Personal Exemptions (Table A) for filing status F has been updated.
- Personal Tax Credits (Table E) for filing status F has been updated.

For more information, see:

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Kentucky

The Kentucky state income tax change is as follows: The standard deduction increased from $2,440 to $2,460.

For more information, see:

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Maine

The Maine state income tax changes are as follows:

- One withholding allowance amount increased from $4,000 to $4,050.
- Withholding tables for Single and Married have been updated.
- The phase-out of standard deduction has been factored in the Percentage Method Calculation.
The nonresident adjustment calculation has been removed.

For more information, see:

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

New Mexico

The New Mexico state income tax changes are as follows:

- The annual allowance increased from $4,000 to $4,050.
- The supplemental withholding rate remains at 4.9 percent.

For more information, see:

Files Updated
Deltek.Vision.PayrollBO.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

State Electronic Filing

Maryland

The W-2 reporting for Maryland now requires the North American Industry Classification System (NAICS) code in the RV Record (positions 333-338, zero-filled, right-justified).

For more information, see:

Files Updated
Deltek.Vision.W2Form.Server.dll
Other Applications Affected

Database Changes

System File Dependencies

Software Enhancements

Intercompany Billing

This applies if you use Intercompany Billing with detailed subledgers (the Enable Detailed Subledgers for Intercompany Billing check box is selected on the General tab in Configuration » Accounting » System Settings).

Previously, the payment term used for intercompany vouchers was always Hold. Now, you determine the payment terms. You enter them in the Payment Terms field on the Accounting tab in the Vendor Info Center—for the special vendor that is set up for a company’s intercompany vouchers. Possible payment terms are Hold, Next, PWP, and the number of days such as 30, 60, and so on.

In the Vendor Info Center, review and select the appropriate payment terms for each existing intercompany billing vendor. These are the vendors who are specified for each company on the Subledger Vendors tab in Configuration » Accounting » Intercompany Billing. When you log into Vision to review and enter the payment terms, be sure to select the company whose intercompany vendor you want to review. This is especially important if the same vendor is used for intercompany vouchers for multiple companies. Make any changes to the Payment Terms field on the Accounting tab in the Vendor Info Center.

- To keep the same functionality as before this software change, select Hold in the Payment Terms field.
- To have intercompany vouchers automatically paid in the next Accounts Payable Payment run, select Next.
- The PWP payment terms is not useful since there is no client payment that will ever release the voucher.
- You can enter a number of days in the Payment Terms field if you want intercompany vouchers paid after a certain number of days have elapsed from the date that the invoice was generated.

Payroll

You can now process payroll for the prior tax year or the current tax year. This means that you may choose to download and install the yearly payroll update to the tax tables that Deltek provides before processing the final payroll for the prior tax year.

If you are processing a payroll for a prior period, you must select the Allow Processing in Prior Period option on the Accounting tab in Configuration » Security » Roles.

Based on the W-2 year selected, Vision selects the appropriate Payroll Tax Withholding tables to calculate system withholding amounts.
If you are processing a regular payroll run, in **Human Resources » Payroll » Form W-2 Processing**, the **Processing W-2 Year** field is automatically populated with the W-2 year that is currently open. The value for the **Current W-2 Year** field is set on the General Tab of **Configuration » Payroll » General**.

If you are processing a bonus or an adjustment run, in **Human Resources » Payroll » Quarterly Processing**, select the year and the quarter for the payroll that you want to process in the **Processing Year** and **Processing Quarter** fields, respectively. You can only select a processing year or a processing quarter if you have been granted rights to do so.

**TrafficLIVE Web Service Utility**

If you own Vision and TrafficLIVE, use the new TrafficLIVE Web Service utility in Vision to link new projects/jobs, employees, and timesheets between Vision and TrafficLIVE.

You use the utility, located in **Utilities » Advanced Utilities » TrafficLIVE Web Service**, to:

- Enable the TrafficLIVE web service to allow the integration between Vision and TrafficLIVE.
- Specify the connection settings for the TrafficLIVE web service so that Vision has access to the TrafficLIVE database.
- Define the mapping of project/job structure, organization levels, and billable and non-billable labor codes between Vision and TrafficLIVE.
- Select the type of new records—project/jobs, employees, timesheets, and/or organizations—that Vision will send to and receive from TrafficLIVE when the TrafficLIVE web service is run. After records are sent and received, they are considered to be “linked” between Vision and TrafficLIVE.
- Specify the fields to update in TrafficLIVE when changes have been made in Vision to employees and projects/jobs that are linked with TrafficLIVE.
- Run or schedule the TrafficLIVE web service to send and receive new records between Vision and TrafficLIVE and synchronize fields that have been changed for linked employees and projects/jobs.

**Configuration**

In addition to the configuration settings that you enter on the Configuration tab and Mapping tab in the TrafficLIVE Web Service utility, you must complete other configuration in Vision and TrafficLIVE before you can link records between Vision and TrafficLIVE. See the *Deltek Vision TrafficLIVE Integration Technical Guide* for complete configuration instructions. This guide also provides information about the data mapping between Vision objects and TrafficLIVE objects and troubleshooting steps for integration issues.

**Creating and Linking Records Between Vision and TrafficLIVE**

When you run the TrafficLIVE web service in Vision, the selections that you make on the General tab of the TrafficLIVE Web Service Form determine which record types will be linked and updated during the process. In addition to this, where you create the new records—in Vision or in TrafficLIVE—determines whether or not a record will be linked or updated. The following table provides a summary of where you must enter new records and make changes to linked records so the new records and changes will be linked and updated in both products when you run the TrafficLIVE web service.
<table>
<thead>
<tr>
<th>Records</th>
<th>Where You Must Create New Records and Make Changes to Linked Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project/Job</td>
<td>• Create new projects/jobs in TrafficLIVE.</td>
</tr>
<tr>
<td></td>
<td>• Make changes to linked projects/jobs in Vision.</td>
</tr>
<tr>
<td>Employee</td>
<td>• Create new employees in Vision.</td>
</tr>
<tr>
<td></td>
<td>• Make changes to linked employees in Vision.</td>
</tr>
<tr>
<td>Timesheets</td>
<td>• Create new timesheets in TrafficLIVE.</td>
</tr>
<tr>
<td>Organizations</td>
<td>• Create new organizations in Vision.</td>
</tr>
</tbody>
</table>

**New Fields Added to the Project Info Center**

To support the TrafficLIVE web service utility, the following fields have been added to the Budget & Revenue tab of the Vision Project Info Center:

- TrafficLIVE WBS ID
- TrafficLIVE Project Name
- TrafficLIVE Charge Band

**Files Updated**

- Deltek.Vision.EmployeeInfoCenter.Client.dll
- Deltek.Vision.EmployeeInfoCenter.Server.dll
- Deltek.Vision.ProjectInfoCenter.Client.dll
- Deltek.Vision.ProjectInfoCenter.Server.dll
- Deltek.Vision.TLWebService.Client.dll
- Deltek.Vision.TLWebService.Server.dll
- navigationMenu.xml
- Labor Detail.rdl
- Labor Summary.rdl
- Office Earnings.rdl
- Project Earnings.rdl
- Project List.rdl
- Deltek.Vision.ReportingProject.Server.dll
- Deltek.Vision.ReportingProject.Client.dll
- DeltekVision75GACU01.sql
Database Changes

- Added column TLInternalKey to BILD, LD and tsDetail
- Added columns LastReceiveProjects, LastReceiveTimesheets and LastSyncFields to CFGIntegrationWS
- Added columns TLProjectID, TLProjectName, TLChargeBandInternalKey, TLChargeBandExternalCode and TLSyncModDate to PR, PRDefaults and PRTemplate
- Added column TLSyncModDate to EMMain, EMIInitiation, CL and Contacts
- Updated the EM and EMCompany views
- Updated the Audit triggers for the affected tables

Software Issues Resolved

Accounting

Accounts Payable

Defect 546194: The Vision 1099-MISC form was printed using font size 8, when the IRS requirement is font size 12.

Customers Impacted: This defect applies to Vision versions 7.3–7.5.

Workaround Before Fix: Submit 1099 data electronically.

Additional Notes: None.

Files Updated
- aprptForm1099.rdl
- aprptForm1099Custom.rdl

Other Applications Affected

Database Changes

System File Dependencies

AP Invoice Approvals

Defect 559903: When using an Advanced Search for AP Invoice Approvals with Purchase Order as the Search criteria, an 'Invalid column name POMasterPKey' error displayed.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
- Lookup_APApproval.xml

Other Applications Affected

Database Changes
System File Dependencies

Defect 555733: On the General tab of Accounting » AP Invoice Approvals, the Project Charge Details grid is not updated when adding additional Purchase Orders to an AP Invoice Approval. An error is encountered when attempting to remove an existing Purchase Order from the AP Invoice Approval.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.APInvoiceApprovals.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Bank Reconciliation

Defect 555263: The Import New Bank Transactions dialog box was not processed or translated correctly when using a Spanish language database.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated
Deltek.Vision.CreditCardReconciliation.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Consultant Accruals

Defect 368660: When the budget source was Planning, there could be rounding differences that resulted in unexpected consultant accrual amounts.
**Customers Impacted:** This defect applies to Vision 7.5 and earlier.

**Workaround Before Fix:** Edit the JE amount before posting.  

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Credit Cards**

**Defect 554445:** Credit Card Reconciliation on Accounting » Credit Cards takes a long time to open when the selected credit card has a lot of associated documents in the Credit Card Charges grid of the Charges tab. The duration it takes to open Credit Card Reconciliation increases if more documents are associated with the credit card.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**

**Database Changes**

**System File Dependencies**

**Void Check**

**Defect 553452:** When an AP Disbursement that included taxes was voided, the tax code caused an unbalanced posting if the AP Disbursement's transaction currency was different from the active company's functional currency.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

**Other Applications Affected**
Database Changes

System File Dependencies

Architecture

**Defect 564347:** The iAccess button only displayed on the Vision toolbar when the CRM module was installed.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**

Deltek.Vision.FrameUI.Client.dll

**Other Applications Affected**

Database Changes

System File Dependencies

Asset Management » Depreciation Processing

**Defect 560801:** When processing depreciation for an asset, the history loading of accumulated depreciation was not included and actual values were also ignored.

**Customers Impacted:** This defect applies to Vision 7.5.

**Workaround Before Fix:** None.

**Additional Notes:** None.

**Files Updated**


**Other Applications Affected**

Database Changes

System File Dependencies
Configuration

General » System Settings

Defect 555257: When automatic numbering was used for items in the Equipment Info Center, the automatic numbers were also assigned for asset items and equipment items that were generated from Purchasing records and Accounts Payable vouchers. This would fail and Vision displayed a 'Column does not exist' error message when there was a standard or user-defined field referenced. This resulted in users not having the ability to post an Accounts Payable voucher or final print a Purchase Order.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: To work around this issue, either turn off autonumbering or do not reference the equipment field as part of a number.

Additional Notes: None.

Files Updated
Deltek.Vision.PORoutines.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Organization » General Setup

Defect 566100: When an employee was assigned to the Approval Roles grid in Configuration » Organization General Setup, the following error displayed: Ambiguous column name 'Employee'. ORDER BY items must appear in the select list if SELECT DISTINCT is specified.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies
iAccess

Defect 564008: If in iAccess you entered planned hours in a calendar period column for a generic resource in an iAccess plan, the ETC column in the grid displayed the correct ETC amount for the resource (if you viewed amounts), but when you saved the entries, the ETC amount for the resource was set to 0. (This problem occurred only with generic resources; named resources were not affected.)

Customers Impacted: This defect applies to Vision 7.5 customers who use the Project Management workspace in iAccess 2.1 or a later version to enter planned hours.

Workaround Before Fix: None.

Additional Notes: Installing this Vision cumulative update resolves this problem in iAccess. iAccess itself requires no upgrade.

Files Updated

Other Applications Affected

Database Changes

System File Dependencies

Info Center

Screen Designer

Defect 471272: An error occurred when you used the Screen Designer and attempted to "show" a column in a custom or standard grid in an Info Center.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: Vision still shows the column for all roles even though the error displays.

Additional Notes: None.

Files Updated
Deltek.Framework.Controls.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Equipment

Defect 559832: When using Vision Multicurrency with Asset Management, assets that were created from Purchase Orders or AP Vouchers were not displaying in the correct currency in the Equipment Info Center.
Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: You can manually adjust the depreciation basis on the GL Cost tab prior to running depreciation.

Additional Notes: None.

Files Updated
Deltek.Vision.PORoutines.Server.dll

Other Applications Affected

Database Changes

System File Dependencies

Projects
Defect 566294: An error message displayed when the List View option was selected from the toolbar in the Project Info Center.

Customers Impacted: This defect applies to Vision 7.4 and 7.5.

Workaround Before Fix: You can ignore the message and continue working in the Project Info Center.

Additional Notes: None.

Files Updated
Deltek.Vision.ProjectInfoCenter.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Planning » Project Planning
Defect 555243: When account or unit rows were added for Expenses, Consultants, or Units, but not at the lowest WBS level, the respective JTD Cost and Quantity fields were blank.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None

Additional Notes: None.

Files Updated
Deltek.Vision.FrameUI.Client.dll
Other Applications Affected

Database Changes

System File Dependencies

Defect 555272: When account or unit rows were added for Expenses, Consultants, or Units but not at the lowest WBS level, the respective JTD Cost and Quantity fields were blank.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None

Additional Notes: None.

Files Updated

DeltekVision75GACU01.sql

Other Applications Affected

Database Changes

The following stored procedures were updated:

- pmGetConTPD
- pmGetExpTPD
- pmGetUntTPD

System File Dependencies

Proposals » Custom Proposals

Defect 549900: When a resume section was merged for a custom proposal, the Project Role and Description did not display on the same line.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Deltek.Vision.allSF254255330Custom.Client.dll

Other Applications Affected

Database Changes

System File Dependencies
Reporting

Employee

Defect 553259: The Home Company fields were not added to the Columns tab.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: You can sort by Home Company to see the employee's home company.

Additional Notes: None.

Files Updated

Employee Ledger.rdl
Employee LedgerDetail.rdl

Other Applications Affected

Database Changes

System File Dependencies

Defect 563699: When Organizations were enabled but Multicompany was not in use, the Time Analysis report did not print hours.

Customers Impacted: This defect applies to Vision 7.5.

Workaround Before Fix: None.

Additional Notes: None.

Files Updated

Time Analysis.rdl

Other Applications Affected

Database Changes

System File Dependencies
Text Editor

Defect 468049: The Text Editor in Vision 7.3–7.5 did not properly format hyperlinks when they were inserted into the Text Editor. As a fix, a new **Format Hyperlinks** button was added.

**Customers Impacted:** This defect applies to Vision 7.3 and later.

**Workaround Before Fix:** Open a Word document and use the **Insert Hyperlink** option. Copy the hyperlink into the Vision Text Editor.

**Additional Notes:** None.

Files Updated

Deltek.Framework.ControlDialogs.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Transaction Center » Transaction Entry

Defect 561315: When the **Asset Item Source** was set to **AP Voucher** in **Configuration » Asset Management**, and an asset was created from an AP Voucher, the **Account number** did not auto update when the **Asset Type** was changed.

**Customers Impacted:** This defect applies to Vision 7.3 and later.

**Workaround Before Fix:** Manually change the account number if you change the **Asset Type**.

**Additional Notes:** None.

Files Updated

Deltek.Vision.DataEntry.Client.dll

Other Applications Affected

Database Changes

System File Dependencies

Utilities

Advanced Utilities » Input Web Service

Defect 553534: When using the GovWin IQ Web Service in **Utilities » Advanced Utilities**, the opportunity records that only had an ID value resulted in an error message and in the IQ import failing.
Customers Impacted: This defect applies to Vision 7.5.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated
Deltek.Vision.IQWebService.Server.dll
Other Applications Affected

Database Changes

System File Dependencies

**VisionXtend**

Defect 555455: You received an error when you did not include the Organization.Name for API updates to the Organization table. You also received an error when you did not include the CFGOrgCodes.Label for API updates to the CFGOrgCodes table. Now, you can omit the Organization.Name and CFGOrgCodes.Label in these API updates, and you will not receive an error.

Customers Impacted: This defect applies to VisionXtend 7.3, 7.4, and 7.5.
Workaround Before Fix: None.
Additional Notes: None.
Files Updated
Deltek.Vision.WebServiceAPI.Server.dll
Other Applications Affected

Database Changes

System File Dependencies
Deltek is the leading global provider of enterprise software and information solutions for government contractors, professional services firms and other project- and people-based businesses. For decades, we have delivered actionable insight that empowers our customers to unlock their business potential. 20,000 organizations and millions of users in over 80 countries around the world rely on Deltek to research and identify opportunities, win new business, recruit and develop talent, optimize resources, streamline operations and deliver more profitable projects. Deltek – Know more. Do more.®

deltek.com